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Purpose of this user bulletin

This user bulletin:

Describes the new features of the GeneMapper® ID-X Software Version 1.4.
Provides instructions for installing GeneMapper® ID-X Software Version 1.4.
Provides troubleshooting information for the installation.

Contains software verification testing information.

technologies”



New features and changes in GeneMapper® ID-X Software Version 1.4

New features and changes in GeneMapper® ID-X Software

Version 1.4

Overview of new GeneMapper® ID-X Software Version 1.4 expands upon the functionality provided in

features Version 1.3 as described below.

* Support for the GlobalFiler'" or GlobalFiler'" Express PCR Amplification Kits:

- Data generated with the GlobalFiler"" Express Kit and the J6 dye set can be
analyzed in GeneMapper® ID-X Software. See “New features” on page 6.

— The following analysis files are provided:

Files automatically
installed and
imported into the
software

Comments

GeneScan™ 600 LIZ®
size standards

e (5S600_LIZ+Normalization_(60-460)
e GS600_LIZ_(60-460)

Panels, bins, table
settings

Updated for the GlobalFiler™ Express Kit

Plot settings

Updated for the GlobalFiler™ Express Kit

IMPORTANT! The 6-dye plot setting starts at 75 bp.
However, the smallest markers in the GlobalFiler™
Express Kit and low molecular weight microvariant
alleles may fall below 75 bp. Therefore, you may want to
decrease the starting size range (for example, to 60 bp)
to ensure all alleles are displayed in plots.

Files automatically
installed

Comments

Stutter settings

Updated for the GlobalFiler™ Express Kit

Stutter files must be imported into the software before
use.

— Y-marker analysis. In addition to the ability to analyze autosomal STR and Y-
STR data separately, GeneMapper® ID-X Software Version 1.4 can analyze
autosomal and Y-STR markers in one multiplexed sample. A new marker-
level PQV, Amelogenin Cross Check (ACC), has been added and the Allele
Number (AN) PQV has been enhanced to evaluate the quality of Y markers
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Issues addressed
in GeneMapper®
ID-X Software v1.4
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designated for analysis in the Panel Manager. Y markers designated in the
Panel Manager are excluded from the Mixture Analysis and Statistical
Calculations performed in the Mixture Analysis Tool. See “Y-marker analysis
overview” on page 6.

By default, the software designates two loci in the GlobalFiler™ panel,
DYS391 and the Y Indel, as Y markers, and processes all other loci as
autosomal.

Spike detection disable/enable. Spike detection functionality has been enhanced
to allow you to disable spike detection for samples and controls. The disable/
enable spike detection for allelic ladders functionality introduced in v1.1.1
remains unchanged. See “Disable spike detection for samples and controls” on

page 6.

Oracle installation errors: The issues with installation of GeneMapper® ID-X
Software v1.3 that caused ORA-12528 and ORA-12541 Oracle errors have been
mitigated. If you observe these errors, see “Troubleshooting” on page 36.

Define New Sample Path function: The Edit » Define New Sample Path
function in the Sample Info view is used if sample files are moved from their
original location. This function now supports .hid files.

JES Population Database update: An update was made to the STR_JFS_Database
and the STR_JFS_D2_D19 Database. The first allele designation for the D851179
marker was updated in the African American population from >9 to <9.



Compatibility with earlier versions of software

Compatibility with earlier versions of software

GeneMappe r® ID-X  All data objects listed below can be imported from any earlier version of

Software GeneMapper® ID-X Software or from GeneMapper® ID Software v3.2.x. All original
values are retained. Values for new functions are set to defaults (for example, Sample
Spike Detection is enabled).

Project Report settings

Analysis method Panel, bins, and stutter

Size standard ' Genotype profiles for profile comparison®
Table settings Mixture Analysis analysis Method™

Plot settings Known reference profiles for Mixture Analysis®
Matrix Audit map configuration®

t Not applicable for GeneMapper® ID-X Software v1.0.1 or GeneMapper® /D Software v3.2.x.

Table sort order: Data in tables is sorted based on dye color, then fragment size. If you
analyze data using overlapping loci that are configured differently in different panel
and bin files (as you may when comparing exported results between 5-dye and 6-dye
data, for example), the sort order may vary.

Data Collection GeneMapper® ID-X Software v1.4 can process data from:
Software » .fsa data files generated on 31xx Series and 310 Genetic Analyzers or 37xx Series
DNA Analyzers

¢ .hid data files generated on 3500 Series Genetic Analyzers

Documentation and support

Related ¢ For more information on features, updates, and known issues for GeneMapper®
documentation ID-X Software v1.4, see the following:

GeneMapper® ID-X Software Version 1.4 Release Notes (Part no. 4477874) located
in <drive>:\ AppliedBiosystems\ GeneMapperID-X\ Docs, where <drive> is
the drive on which you installed the GeneMapper® ID-X Software.
GeneMapper® ID-X Software Help — Start the GeneMapper® ID-X Software
and press F1 or select Help » Contents and Index. To access context-
sensitive help in the software application, click & or Help, located on
selected windows and dialog boxes.

* Related product documentation is also available in Adobe® Acrobat® format
(.pdf), including:

GeneMapper® ID-X Software v1.0 Administrator's Guide (Pub. no. 4376327)
GeneMapper® ID-X Software v1.0 Getting Started Guide (Pub. no. 4375574)

GeneMapper® ID-X Software v1.1 Getting Started Guide: Mixture Analysis Tool
(Pub. no. 4396773)

GeneMapper® ID-X Software v1.1 Quick Reference Card: Mixture Analysis Tool
(Pub. no. 4402094)

GeneMapper® ID-X Software v1.2 Installation Guide (Pub. no. 4425023)
GeneMapper® ID-X Software v1.2 Reference Guide (Pub. no. 4426481)
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—  GeneMapper® ID-X Software v1.2 Quick Reference Card (Pub. no. 4426482)
—  GeneMapper® ID-X Software v1.3 User Bulletin (Pub. no. 4470483)

—  Applied Biosystems® 3500 Series Genetic Analyzer Data Collection Software v2
User Guide (Pub. no. 4476988)

—  Applied Biosystems® 3130 Series Genetic Analyzer Data Collection Software v4
Getting Started Guide (Pub. no. 4477796)

—  Applied Biosystems® 3730 Series DNA Analyzer Data Collection Software v4
Getting Started Guide (Pub. no. 4478016)

To open the documentation, use the Adobe® Acrobat® Reader® software
available from:

www.adobe.com

For details on analysis method settings to use, refer to the user guide provided
with the STR kit you are using.

Obtaining support  For HID support:

In the United States and Canada — send an email to
HIDTechSupport@lifetech.com, or call 888-821-4443 option 1.

Outside the United States and Canada — contact your local support office.

For the latest services and support information for all locations, go to:

www.lifetechnologies.com/support

At the web site, you can:

Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities.

Search through frequently asked questions (FAQs).
Submit a question directly to Technical Support.

Search for user documents, Safety Data Sheets (SDSs), vector maps and
sequences, application notes, formulations, handbooks, certificates of analysis,
citations, and other product support documents.

Download .pdf documents.
Obtain information about customer training.

Download software updates and patches.
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New features

New features

Six-dye fragment
analysis

Disable spike
detection for
samples and
controls

Y-marker analysis
overview

GlobalFiler™ Kit Series use the J6 dye set listed in the following table. All software
fields that display genotypes include the purple dye (P).

Note: Six-dye fragment analysis is not supported on 3100 Series or 310 genetic
analyzers.

Dye Color
6-FAM™ Blue
vIc® Green
NED™ Yellow
TAZ™ Red
SID™ Purple
LIz® Orange (reserved for size standard)

Spike detection functionality has been enhanced to allow you to disable spike
detection for samples and controls. The disable/enable spike detection for allelic
ladders functionality introduced in GeneMapper® ID-X Software v1.1.1 remains
unchanged.

If enabled, the software examines samples and controls and updates the SSPK and SPK
PQVs according to the table below.

If disabled, SSPK (Sample Spike) and SPK (Marker Spike) PQVs are set to N/A for
sample, positive control, and negative control samples.

Flag Indicator Description
Pass [l No spikes are detected within the range.
Check One or more spikes are detected within the range.
NA PQV does not apply.
or d At least one label in the marker was edited or the GQ was overridden.

The following functionality was added or modified in GeneMapper® ID-X Software
v1.4 to support the analysis of samples that contain both Y and autosomal STRs:

* Y-marker check box added to the Panel Manager

* New Amelogenin Cross Check PQV (ACC)

e Modified Allele Number PQV (AN)

* Modified Mixture Analysis functionality

* Modified Duplicate Homozygous Allele Label functionality
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Y-marker check
box added to the
Panel Manager

Panel Manager

The Panel Manager (Tools » Panel Manager) includes a Y-Marker check box for each
locus, which allows you to specify any marker as a Y-marker.

This checkbox is used by the software to apply Y-marker handling rules for the ACC
PQV, AN PQV, Mixture Analysis tool, and the Duplicate Homozygous Allele Label
functions (described in more detail in sections that follow).

By default, the panel for the GlobalFiler " Kits includes DYS391 and the Y Indel
selected as Y markers, and processes all other loci as autosomal. However, any locus in
any AmpF(STR® kit can be designated as a Y marker.

Figure 1 Panel for the GlobalFiler™ Express Kit with DYS391 and Y Indel selected as Y markers

#* Panel Manager

File Edit Bins View Help

wib X @ E E | W™ s Set=|AmDFLSTR_Bin5_V3>< V| WLESESE BREEEEERNE <
=)~ 2, Panel Manager A | |Bbr Hume  [Dye Color M Sise |Max Size | Gontrol Alleles Barker | Cormmrts | % Marker | | Ladder Alleles
= () AmpFLSTR_Panels_vax 1 [oiee Ble  [90.5  [146.5  |15,16 4 none 0 9,10,11,12,13,14,15,16,17,15,19,20
-gProfiler_vl.ZX Z | Blue 151.0  |215.0 14,16 4 nane 0 11,12,13,14,15,16,17,18,19,20,21,22,23,24
A COfiler _v1.2%
- D165539 Ei 2215  |273.5  |9,10 4 5,8,9,10,11,12,13,14,15
I Profiler_Plus_v1,2% s e ! fons O e
[C)5GM_Plus_v1.2% 4 |csFiPo Blue  |z77.0 |azs.0  [11,12 4 none 0 6,7,89,10,11,12,13,14,15
[C3)Sefiler_Plus_v1.2% 5 |TPOX Ble  |332.5 |384.5 |8 4 none T [[56788101512,13,14,15
'gldef'“l“ﬁ'erl—”-zx & |vindel Green  |795  |87s |2 5 none 2NIE
hProfiler_Plus_CODIS_wl. 28
it G AMEL G 97.0  |107.5 ] P
[E)COfiler_CODIS_vl.2% 7 sl ok fons A= ]
[ Identifier_CODIS v1,2% & |Dasii7e Green  |108.5  [176.5  |12,13 4 none 0 5,6,7,8,9,10,11,12,13,14,15,16,17,15,19
[CMiniFiler 1,2 a |pz1si1 Green  |179.5  |246.5  |28,31 4 none 0 24,24.2,25,26,27,28,28.2,29,29.2,30,30,2,31,3
CnGM_v3.2% 10 |D18551 Green  |255.5  |347.5  |12,15 4 nane Ju| 7,9,10,10.2,11,12,13,13.2,14, 14.2, 15, 16,17, 1
[C31dentifiler_Plus_v1.2%
Catdentiier_Plus_v 11 |Ds391 Green  |359.5  |395.5 |11 4 none v 7,8,9,10,11,12,13
() Identifiler_Direct_v1,2% [v]
= 12 |D25441 velow |75.0  [113.5  |14,15 4 none TI [[e.510,11,11.5,12,15,14,15,16,17
| |13 |D13s4a3 velow [115.5  [173.5  |14,15 4 none 0 6,7,8,9,10,11,12,12.2,13,13.2,14,14.2,15,15.2
- [LINGM_SElect 2,24 14 |THO1 vellow |174.0  |218.5  |7,9.3 4 nane 0 4,5,6,7,8,9,9.3,10,11,13.3
- [CI)NGM_SElect_E L1 v
| E-EDNGM. SFlect Frpross v 15 FGA velow |221.0  |380.0  |24,26 4 none 0 13,14,15,16,17,18,19,20,21,22,23,24,25, 26,26
""" afnReference Samples 16 |DZ2s1045 Red 53,5 1265 |11,16 3 none O ,9,10,11,12,13,14,15,16,17,18,19
17 |DssalE Red 1335 1895 |11 4 none 0 7,8,9,10,11,12,13,14,15,16,17,18
18 |D135317 Red 197.0  |249.0 |11 4 none 0 5,6,7,8,9,10,11,12,13,14,15,16
19 |D7s820 Red  |256.5 |a04.5  |7,12 4 none 0 6,7,89,10,11,12,13,14,15
20 |5E33 Red  |306.0 |444.0 |17,25.2 4 none 0 4.2,6.3,8,9,11,12,13,14,15,16,17,18,19,20,20,
21 |D1051248  |Purple  |80.0  [132.0  [12,15 4 none 0 8,9,10,11,12,13,14,15,16,17,15,19
22 |D151656 Purple  [154.0 |209.5  |13,16 4 none 0 9,10,11,12,13,14,14.3,15,15.3,16,16.3,17,17.2
23 |D125391 Purple  |211.0  |270.5  |18,19 4 none 0 14,15,16,17,15,19,19,3,20,21,22,23,24,25, 26,
24 |D251338 Purple  |275.5  |355.5  |20,23 4 none & 11,12,13,14,15,16,17,18,19,20,21,22,23,24,25
£
[ OF ] [ Cancel ] [ Apply ] [ Help ]
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New features

New Amelogenin
Cross Check PQV
(ACC)

Using the new Y marker functions with the AmpF(STR® Yfiler® PCR Amplification
Kit

The Y marker checkbox in the Panel Manager is unselected by default in the Yfiler
panel provided with the software. To use the new Y marker functions, select the
Y marker checkbox for each Yfiler® Kit locus in the Panel Manager.

The ACC PQV is applied only to samples that contain both the Amelogenin marker
and 1 or more Y markers and designated in the Panel Manager. For example, Yfiler®
Kit samples do not contain the Amelogenin marker, and therefore will not be subject to
the ACC PQV.

The new Amelogenin Cross Check PQV (ACC) is a marker-level PQV that is applied to
samples containing the Amelogenin marker and Y markers that have been designated
in the Panel Manager as described above. It indicates if Amelogenin and Y marker
results are concordant. The same flag is displayed for Amelogenin and all designated
Y markers. When viewing a sample, the Quality Value Details (QVD) panel in the
Genotypes plot displays a description for a ;* ACC value.

Flag Indicator Description
Pass [l Sample or positive control contains the amelogenin marker and one or
more Y markers, and amelogenin and all Y marker results are
concordant.
Check Amelogenin and one or more Y marker results are not concordant:

* Amelogenin genotype is not X, X or XY (for example itis X,0L, OL,0L,
or Y only - no X allele detected).

¢ Amelogenin genotype is X or X,X but one or more Y markers contain
called alleles.

¢ Amelogenin genotype is X,Y and one or more Y markers do not
contain called alleles.

Note: Peaks identified and labeled by the software as spikes are not
considered in the ACC PQV.

NA ¢ Negative control.

e Allelic Ladder.

e Sample or positive control that does not contain both the Amelogenin
marker and at least one Y marker selected in the Panel Manager (for

example, samples generated with the AmpFISTR® Yfiler® PCR
Amplification Kit, which does not contain Amelogenin).

or At least one label in either the amelogenin or Y marker(s) was edited
or the GQ was overridden.

The ACC result is a composite result that begins with the analysis of the Amelogenin
marker, before considering Y-marker results. Therefore, the ACC PQV will be flagged
as ;. (for both Amelogenin and any Y markers that have been selected in the Panel
Manager) if:

¢ The Amelogenin marker contains more than two alleles.

* The Amelogenin marker contains one or more OL alleles.

Table 1 on page 9 shows the possible ACC results for the GlobalFiler'" Express Kit. The
ACC is marked as [ only if both Y markers also contain at least one called allele.
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Table 1 ACC results for the GlobalFiler™ Express Kit

Number of alleles detected Number of alleles detected
Amelogenin® X, Y Amelogenin X, X
DYS391 result Y-Indel result Acc DYS391 result Y-Indel result Acc
result result
1 or more 1 or more Pass [l 1 or more 1 or more Check
1 or more Not present Check ;% 1 or more Not present Check ;%
Not present 1 or more Check Not present 1 or more Check
Not present Not present Check ;. Not present Not present Pass [l

T Spikes in the Amelogenin marker are not considered.

The ACC can be used to determine a sample Genotype Quality (GQ) value by setting
weighting in the Analysis Method SQ & GQ Settings tab.

Note: The values shown in the figure are for example only. Perform internal validation
studies to determine the appropriate setting to use for your analysis.

Analysis Method Editor. [g|

| General | Alles | Peak Detector | Pesk Qus

Quality weights are between 0 and 1.
rSample and Contral GG Weighting

Broad Peak (BD) @ Allele Mumber (AR)

Out of Bin Allels (BIN) los | Low Peak Height (LPH)

Orverlap (OVL) |.D.8 | IMax Peak Height {MPH}
oz | Off-scale (03)

AMEL Cross Check (ACC) (0.5 | Peak Height Ratio (PHR)

Control Concordance {CC) Weight = 1.0 {Only applicable to controls)

50 Weighting ‘

Broad Peak (ED) [os

rallelic Ladder G Weighting

Spike (S5PKJSPK) 1w Off-scale (O5) 1 v
-S0) & GO Ranges-
| T |
Sizing Quality: Fram |0.75 | ko 1.0 From0.0to !0.25 |

Genotype Quality:  From  |0.75 | to 1.0 From 0.0 ko |D.25

Reset Defaults

Save As J[ Save H Cancel H Help ]
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New features

Modified Allele

Number PQV (AN)

10

The Allele Number PQV (AN) is a marker-level PQV that indicates if the software
detects the expected number of alleles within a marker size range. The functionality of
this PQV has been enhanced to define a separate threshold for Y markers (designated
in the Panel Manager) in addition to autosomal markers:

Flag Indicator

Description

Pass [l

At least one allele and not more than the Max Expected Alleles are
detected for the marker, or the X allele is detected for the Amelogenin
marker.

Check

e More than the Max Expected Alleles are detected for any markers
specified as Y markers in the Panel Manager.

¢ More than the Max Expected Alleles are detected for Autosomal/
Amelogenin markers.

¢ No alleles are detected for autosomal or amelogenin markers.
¢ No X allele is detected in Amelogenin.

[ or

At least one label in the marker was edited or the GQ was overridden.

In the Analysis Method Peak Quality tab, the AN threshold can be set separately for
autosomal markers/Amelogenin and Y markers (designated in the Panel Manager).

Note: The values shown in the figure are for example only. Perform internal validation
studies to determine the appropriate setting to use for your analysis.

Analysis Method Editor.

General | Allele | Peak Detector

3

50 & G0 Settings

Min/Max Peak Height (LPHIMPH])
Homozygous min peak height
Heterozygous min peak height

IMax Peak Height {MPH}

Peak Height Ratio {PHR)
Min peak height: ratio

Broad Peak (BD)
Max peak width (basepairs)

200.0

100.0

5000.0

0.7

Allele Mumber (AR
Max expected alleles:
For autosomal markers & AMEL

Far ¥ markers

Allelic Ladder Spike

Spike Detection Enable
Cut-off Yalue 0.2
Sample Spike Detection
Spike Detection Enable
Factory Defauls
[ Save ] [ Cancel ] [ Help ]

Note: The DYS385 marker in the Yfiler® Kit may include two alleles. If this marker is
designated as a Y marker in the Panel Manager and the default Y marker AN threshold

of 1is used, AN will be

if two alleles are detected.
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Modified Mixture
Analysis
functionality

The AN threshold can be used to determine a sample Genotype Quality (GQ) value by
setting weighting in the Analysis Method Peak Quality tab.

Note: The values shown in the figure are for example only. Perform internal validation
studies to determine the appropriate setting to use for your analysis.

Analysis Method Editor.

| General | Allele || Peak Detector | Peak Qua

Quality weights are between 0 and 1.
rSample and Control GG Weighting

Broad Peak (BD) fD.S | Allele Mumber (AN} 'T
Out of Bin Allels (BIN) o8 Low Peak Height (LPH) e
Overlap (OVL) 08 Mas Peak Height (MPH) 03 ]
Marker Spike (SPK) o3 | Off-scale (05 Ios j
AMEL Cross Check (ACC) _0.5 | Peak Height Ratio {(PHR) |0.3 |

Control Concordance (CC) Weight = 1.0 {Only applicable to controls)

50 Weighting ]
Broad Peak (ED) [0

rallelic Ladder G0 Weighting

Spike (SSPKJSPK) 1 ¥ Off-scale (O5) [1 %]
50 &G0 Ranges

PassRange:  [OUSIERSHEE

Sizing Quality: Fram |0.75 to 1.0 From 0.0 ko _0.25
Genotype Quality:  From  |0.75 | to 1.0 From 0.0 ko .0.25
Reset Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]

Y markers that have been designated in the Panel Manager are displayed in the
Mixture Analysis Plot Viewer along with the autosomal markers, but are not
considered in the Mixture Analysis calculations.

If you select a sample that contains only Y markers (designated in the Panel Manager),
the software displays a message and excludes the entire sample from processing.

If you select a sample that contains autosomal and Y markers (as designated in the
Panel Manager), the Mixture Analysis software displays a message indicating that Y
marker data is excluded from calculations. In the Mixture Analysis Plot Viewer, Y
marker alleles (designated in the Panel Manager) will be displayed in gray to indicate
that the Mixture Interpretation Threshold and Mixture Analysis calculations are not
applied to the Y marker data.

When you export data from the Mixture Analysis Tool:

* Loci designated as Y markers are not included in the calculated data and are not
included in the list of Missing Markers (the Missing Markers list contains loci that
do not produce interpretable results).

* Loci designated as Y markers in the Panel Manager are listed as excluded from
mixture analysis. If a sample does not contain Y markers, the excluded marker
field is shown as N/A.
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Computer requirements

Modified Duplicate
Homozygous Allele
Label functionality

The Duplicate Homozygous Allele Label functionality in Project Options has been
modified to accommodate Y markers (designated in the Panel Manager) in addition to

autosomal markers. When enabled:

¢ Autosomal markers — Single alleles are displayed in the Genotypes table with
two labels to indicate presumed homozygotes.

* Y-markers — Single alleles in Y markers (designated in the Panel Manager) are

displayed with a single label.

Computer requirements

TCPIP

Network
recommendation

12

Recommended configuration
(for optimal performance)

Minimum requirements

Core 2 Duo 3 GHz or newer

Core 2 Duo 2.2 GHz or compatible

4 GB RAM
200 MB available on boot drive

2 GB RAM
200 MB available on boot drive

10 GB available on install drive
(full install)

450 MB available on install drive
(client install)

DVD-ROM drive

10 GB available on install drive
(full install)

450 MB available on install drive
(client install)

DVD-ROM drive

10/100 NIC with RWU (internal) or above
installed

10/100 NIC with RWU (internal) or above
installed

TCP/IP installed

TCP/IP installed

Microsoft® .NET Framework 2.0 or later

Microsoft® .NET Framework 2.0 or later

IMPORTANT! Ensure that the computer name does not contain spaces, special
characters, or non-alphanumeric characters (! % in particular). Special characters in the
computer name may interfere with installation of the Oracle® software.

TCP Internet Protocol (TCP/IP) is integral to the communication between the user
interface of the GeneMapper® ID-X Software and the Oracle® database in which data
is stored. TCP/IP is also the protocol your computer uses to access the internet and
local intranets within a local network. Any disruption in the TCP/IP connection will
disconnect the GeneMapper® ID-X Software from the Oracle® database.

To minimize disconnection issues between the GeneMapper® ID-X Software and the
Oracle® database, use a cable-based network system, such as a CAT5e network, with
plug-in Network Interface Controller (NIC) cards rather than wireless NIC cards. The
GeneMapper® ID-X Software uses TCP Internet Protocol (TCP/IP) to communicate
between the user interface and the Oracle® database. Any disruption in the TCP/IP
connection will disconnect the GeneMapper® ID-X Software from the Oracle®
database. For more information, see “Troubleshooting” on page 36.
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Procedures to perform before installation: Windows® XP
Operating System (0S)

You must perform all procedures in this section before installing the software:

“Check user access” on page 13
“Modify antivirus, firewall, and network computer settings” on page 14

“Export data objects and settings from the current version of GeneMapper® ID-X
Software” on page 15

“Uninstall GeneMapper® ID-X Software or Oracle® software” on page 15
“Check virtual memory settings” on page 15

“Clear Windows® XP application and system logs” on page 17

“Check Microsoft NET Framework version” on page 18

“Restart the computer and recheck virtual memory settings” on page 19

Check user access You must log on to the local computer using a local account with administrator
privileges (read, write, and execute [rwx] permissions). The local computer is typically
identified in the log in dialog box by the text “(this computer)” after the computer
name.

A local computer account may be different from the account you normally use to log in
to the computer. The local account:

Can not include network domain policies that restrict access to the install drive of
the local computer account.

Can not restrict access to the operating system by firewall or other security
configurations.

To check user access:

1.

Select Control Panel » User Accounts.

GeneMapper® ID-X Software Version 1.4 User Bulletin 13
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Modify antivirus,
firewall, and
network computer
settings

14

2. In the Users tab, verify that your user account belongs to the Administrators
group and that the domain name is the same as the computer name. (The ora_dba
group will be added to your account after you install the software.)

2.

User Accounts

Users | Advanced

Use the list below to grant or deny users access to your
computer, and to change passwords and other settings.

Users for this computer:

User Mame Domain Group
lg»‘-u:lminish'ator MAFSAILUSISLOZ  Administrators
5_alt ADS Debugger Users
ﬂsailusjs Administrators

ADS
o CNAFSALUSISOC ora_dbo; - |
[

Belongs to the
Administrators

[ Add.\. H Remove H Properties ] Domain is the
same as the
computer name

Password for sailuslocal

g To change the password for sailuslocal, dick Reset

Password.
Reset Password...

OK H Cancel ]

Disable Antivirus software (including anti-malware software) before the
installation.

Disable Firewalls before the installation.

Ensure that your network access meets the following conditions:

*s Network Connections

Do not use a wireless network. Use a cable-based network system, such as a
CAT5e network, with plug-in Network Interface Controller (NIC) cards
rather than wireless NIC cards. The GeneMapper® ID-X Software uses TCP
Internet Protocol (TCP/IP) to communicate between the user interface and
the Oracle® database. Any disruption in the TCP/IP connection will
disconnect the GeneMapper® ID-X Software from the Oracle® database.

Only one network should be connected. Go to Settings » Network
connections. If more than one network is connected, right-click then select
Disable until only one network connection is listed.

All virtual network adapters are disabled (refer to manufacturer
documentation for instructions).

Laptop computers — Wireless network connections are disabled.

EEx

r

File Edit View Favorites Tools  Advanced  Help i

e Back ~ () l_? P ) Search {7 Folders D | ¥ x n

Address |\;; Metwork Connections v| e
Marme Type Status Device Mame
Dial-up

1 Mabile Dial-up Disconnected Standard 336§
LAN or High-Speed Internet

M Local Area Connection 3 LAM or High-Speed Inter...  Connected Intel{R) 8256

21,1394 Connection LAM or High-Speed Inter...  Copnected 1394 Met Ade

) wireless Netwark Connection LAM or High-Speed Inter... {Disabled InkeliR) WiFi II
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Export data objects
and settings from
the current version
of GeneMapper®
ID-X Software

Uninstall
GeneMapper® ID-X
Software or
Oracle® software

Check virtual
memory settings

e Computers running a full version of GeneMapper® ID-X Software (contains
the database): Export the data objects or settings you would like to restore after
upgrade (analyzed projects, analysis methods, plot settings, etc.). For information,
refer to the GeneMapper® ID-X Software online help.

e Computers running a client version of GeneMapper® ID-X Software: Export is
not required.

e Computers running GeneMapper® ID Software v3.2: Do not export at this time.
You will be prompted to export during the installation.

Uninstall GeneMapper® ID-X Software, any other programs that use Oracle databases,
and any existing versions of Oracle databases, whether Life Technologies products or
products from other companies. Go to Start » Control Panel » Add or Remove
Programs.

After uninstallation, Ensure that the GeneMapper® ID-X Software is uninstalled (go to
Start » Control Panel » Add or Remove Programs and make sure it is not listed.

If it is still listed, manually uninstall the software (see “If the GeneMapper® ID-X
Software is still listed after uninstalling (tested on Windows® XP only)” on page 38).

1. On the desktop, right-click My computer, select Properties » Advanced, then
click Settings in the Performance section.

System Restors Automatic Updates Remote
General Computer Name Hardware Advanced
You must be logged on as an Administrator to make most of these changes.

Performance
Visual effects, processor scheduling, memory usage, and virtual memory

User Profiles
Desktop settings related to your logon

Startup and Recovery

System startup, system failure, and debugging information

[ Environment Variables H Emor Reporting ]
[ oK ] [ Cancel ]
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16

2. In the Performance Options dialog box, click the Advanced tab, then click Change
in the Virtual Memory section.

Performance Options

Visual Effects | Advanced |Data Execution Prevention

Processor scheduling

By default, the computer is set to use a greater share of
processor time to run your programs.

Adjust for best performance of:
(%) Programs (O Background services

Memory usage

By default, the computer is set to use a greater share of
memory to run your programs.

Adjust for best performance of:
@ Programs O System cache

Virtual memary

A paging file is an area on the hard disk that Windows uses as
if it were RAM,

Total paging file size for all drives: 2046 MB

P ——
)

[ OK H Cancel ]

3. In the Virtual Memory dialog box, select the C: drive. Click the Custom size radio
button. Specify 2046 MB for initial and 4092 for maximum size.

IMPORTANT! The exact Maximum Size necessary may depend on your computer
configuration. If installation still fails when using these values, or if Oracle®
ORA-12528 and ORA-12541 errors are displayed, increase the Maximum size to at
least 2X the physical memory (the minimum required for the installation of
Oracle® software) up to the value shown for Space Available, then repeat the
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Clear Windows®

XP application and

system logs

installation. To determine the physical memory for your computer, right-click My

Computer on the desktop, select Properties, then look for the RAM value on the
General tab. Example: If the physical memory is 3.0 GB RAM, set the Maximum

Size to 6000.

Paging File Size (MB)

C: 2046 - 12000

Paging file size for selected drive

Drive: (L=
| Space available: 155803 MB |

Initial size (MB): 2046

Maximum size (ME): | 4092

(O System managed size
(O Mo paging file Set

Total paging file size for all drives
Minimum allowed: 2MB
Recommended: 5302 MB
Currently allocated: 2046 MB

[ OK ] [ Cancel

Click Set, then click OK.

These settings are not activated until you restart the computer.

Select Start » Settings » Control Panel » Administrative Tools » Event Viewer.

Right-click Applications, then select Properties.

B Event Viewer

File  Action VWiew Help
l:a] B @
Event Viewer (Local)

. Application

24| Security

Syskem

24| BCEEventLog

24| Inkernet Explorer

24| Microsoft OFfice Diagnostics
24| Microsoft OFfice Sessions

Open Log File. ..
Save Log File As...
Mew Log View
Clear all Events

Rename
Refresh

Opens the properties dialog box for the current

Help

GeneMapper® ID-X Software Version 1.4 User Bulletin

Description
Application Error 3
Security Audit Records
Syskem Error Records
Custom Log Error Records
Custom Log Error Records
Custom Log Error Records
Custom Log Error Records

512.0 KB
S12.0KE
S12.0KE

64,0 KB
S76.0KE
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3.

Check Microsoft

.NET Framework 1.
version
2.
3.

18

In the Application Properties dialog box, set the Maximum Log Size to 10048, then
click Clear Log.

Application Properties

General | Filter

Dizplay name: Application
Log name: C:AWIND OW S \apstem32hconfightppE vent Evt
Size: 512.0 KB [524.288 bytes)
Created: Tuesday, February 03, 2004 11:06:42 Ak
Modified: Monday, August 06, 2012 12:21:59 PM
Accessed: Monday, August 06, 2012 12:21:59 PM

Log zize

Manimum log size: | 10048 i

When maximum log size is reached:

(O Ovenwiite events as needed

(®) Ovenwiite events older than |7 * | days
v
(O Do nat avenarite events
[clear log manually] Festore Defaults
[ Using a low-speed connectian Clear Log
QK ] [ Cancel ] [ Apply ]

Click OK.
Right-click System, then select Properties.

In the System Properties dialog box, set the Maximum Log Size to 10048, then
click Clear Log.

Click OK.

Ensure that a version of 2.0 or later is installed on the computer:

Select Start » Settings » Control Panel » Add or Remove Programs.

Scroll down and determine if a version of 2.0 or later is installed. (There may be
multiple versions installed. Do not remove any versions of the software.)

¥ Add or Remove Programs
=1

Currently installed programs:

Change or
Remove % Microsoft \MET Frameswork 1,1
Programs ¥ Microsoft \MET Framewark 2.0 Service Pack 2
- 5 Microsoft JNET Framework 3.0 Service Pack 2 Version 2.0 or h [} her is req uired
o
Add New Iﬁl Microsoft \MET Framework 3.5 5P1
Dvmmvarae -

If a version of 2.0 or later is not installed, insert the v1.4 Full installation or Full
Upgrade DVD in the DVD drive. Navigate to the DotNet directory, then
double-click NETFx20SP2_x86.exe to launch the Microsoft NET Framework 2.0
Service Pack 2 (SP2) installer.
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Restart the

% Microsoft .NET Framework 2.0 SP2 Setup

Microsoft

welcome to Setup 'n_et Fra mework

Be sure to carefully read and understand all the rights and restrictions described in the
license terms, You must accept the license terms before you can install the software:

MICROSOFT SOFTWARE SUPPLEMENTAL

In o m a  —r—— —

Press the Page Down key to see more text,

()1 DO NOT ACCERT the terms of the License Agreement

[]send information about my setup experiences ko Microsoft Corporation.
Details regarding the data collection palicy

[ Install = ][ Cancel ]

4. Read and accept the end user licensing agreement, then click Install.

5. After installation completes, verify the Microsoft NET Framework 2.0 SP2 was
successfully installed (select Start » Settings » Control Panel » Add or Remove

Programs).

® Add or Remove Programs

@

Set Program
Access and
Defaults

e B
t&-&j Currently installed programs; [0 show updates
Change of [y T2 DL LTI LTIl DTS 0 O UpUate T
Remove . .
Programs :g J25E Runtime Environment 5.0 Update &
|éj JavaiTM) 6 Update 22
E a || 2] JavalTM) 6 Update 5
PArdodgr%?-n“; % Microsoft \MET Framework 1,1
nioil Microsoft NET Framework 2.0 Service Pack 2
@ Click here For suppott information.
Add/Remove To change this program or remoye Ik from your computet, click Change or Remoyve,
Windows
Caomponents

IF: Micrasoft Office Professional Edition 2003
m%! Microsoft Wisual C++ 2005 Redistributable

/@ mozila Firefox (3.6,20)

[ MSHML 6.0 Parser (KBI33579)

-«3 Mycoplasma Assay Software Module

|15 MVIDIA Drivers

Q PowerDYD

| # Rioxio Creator Audio

| % Roxio Creator BDAY Plugin
“ Roxio Creator Copy

e

Sort by: | Name

DIzET

Size
Size

Size

aize

Uséd

Size

Size

Size

Size

Size

Size

TS U0E™

152, 00ME

191.00ME

228.00MB

Remove

246,00MB

5.21ME

27.21MB

1.31MB

1.12ME — |

33.51MB

~ |

I

computer and installing the software.
recheck virtual

memory settings on page 15 and ensure that the new settings are activated.
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To activate the changes made in the previous sections, restart the computer before

After the computer restarts, follow the procedure in “Check virtual memory settings”
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Procedures to perform before installation: Windows® 7 Operating

System (0S)

Check user access

20

You must perform all procedures in this section before installing the software.

“Check user access” on page 20
“Modify antivirus, firewall, and network computer settings” on page 22

“Export data objects and settings from the current version of GeneMapper® ID-X
Software” on page 22

“Uninstall GeneMapper® ID-X Software or Oracle® software” on page 22
“Check virtual memory settings” on page 23

“Check notification settings” on page 26

“Check Microsoft NET Framework version” on page 26

“Restart the computer and recheck virtual memory settings” on page 27

You must log on to the local computer using a local account with administrator
privileges (read, write, and execute [rwx] permissions). The local computer is typically
identified in the log in dialog box by the text “(this computer)” after the computer
name

A local computer account may be different from the account you normally use to log in
to the computer. The local account:

Can not include network domain policies that restrict access to the install drive of

the local computer account.

Can not restrict access to operating system firewall or other security
configurations.

Check Local status

1. Select @) » Control Panel » User Accounts. Click Configure advanced user

profile properties.

(=[O el
o 1
I\../”\../I " ontrol Panel terms » User Accounts v | ¥4 =arch Control Pane
2« allc | Panel I User &, +. Search C iPansl |
®
Control Panel Home N
Make changes to your user account
Manage your credentials
Change your password —
Create a password reset disk ini
e Remove your password | I',I.: Adml_ms'“
Link online IDs _ 2| Administr...
Change your picture Il "0 Password ...
Manage your file encryption
certificate
Configure advanced user ®Y Manage another account

LR PO ) Change User Account Control settings

Change my environment
variables

See also

¥y Parental Controls

GeneMapper® ID-X Software Version 1.4 User Bulletin



2. Select your local user account and ensure that the Type is Local.

User Profiles @

User profiles store settinkfor wour deskkop and other
Q information related to your user account, You can create a
3 different profile on each computer you use, or vou can select a
roaming profile that is the same on every computer you use,

Profiles stored on this computer:

>

Status Ma...

Local

5,1’..

Sl Local A
OPTIPLEX-%E-S¥\Adminis... 15.4 GB Local Local T
OPTIPLEX-XE-SY\IMNSTR-... 115ME  Local Local S
OPTIPLEX-XE-SY\IMNSTR-... 132 ME  Local Local S
OPTIPLEX-%E-SYigatest12 46,6 MB  Local Local 5. |
MPTTRI FY-¥F-SWlvitaswcen  G7 1 MR I acal Loeal ot b

Change Type... Delete Copy To...

Ta create new user accounts, open User Accounts in Control Panel,

[ [0]4 ] [ Cancel

Check Administrator privileges
1. Right-click My Computer, then select Manage.

2. In the Computer Management dialog box, click Local Users and Groups, then
double-click Groups.

E'é'. Computer Management EI@

File Action ‘iew Help

A Computer Management (Local]| [ame Actions
a [J} System Toals

- Local User.,, &
3 @ Task Scheduler F g oy
» [2] EventWiewer N P Mare .. P

5 are alders

= Device Manager

4 3 Storage
=f Disk Managernent
T Services and Applications

4 1 | r [ 1 | »

3. Double-click Administrators. Ensure that your local account is listed in the
Administrators group.

Administratars Properties @
General

@ Adminizstrators

Description: Adminiztrators have complete and urrestricted access
to the computer/domain

Members:

& sBService
A s drmiriistrator
B INSTR-ADMIN

ai
(B MyLocalbeoounty
Changes to a uzer's group membership

Add... Femove are not effective until the nest time the
uzer logs on.
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Modify antivirus,
firewall, and
network computer
settings

Export data objects
and settings from
the current version
of GeneMapper®
ID-X Software

Uninstall
GeneMapper® ID-X
Software or
Oracle® software

22

1. Disable Antivirus software (including anti-malware software) before the
installation.

2. Disable Firewalls before the installation.

3. Ensure that your network access meets the following conditions:

* Do not use a wireless network. Use a cable-based network system, such as a
CAT5e network, with plug-in Network Interface Controller (NIC) cards
rather than wireless NIC cards. The GeneMapper® ID-X Software uses TCP
Internet Protocol (TCP/IP) to communicate between the user interface and
the Oracle® database. Any disruption in the TCP/IP connection will
disconnect the GeneMapper® ID-X Software from the Oracle® database.

* Only one network should be connected. Go to Control Panel » Network and
Sharing center. If more than one network is connected, double-click a
connection, then select Disable until only one network connection is listed.

e All virtual network adapters are disabled (refer to manufacturer
documentation for instructions).

e Laptop computers — Wireless network connections are disabled.

u@v| X » Control Panel » Al Control PanelItems » Metwork and Sharing Center - | +4 | | Search Control Panel

[7]
Control Panel Home . . . . .
View your basic network information and set up connections

Change adapter settings -.L Ith @ See full map

Change advanced sharing

settings OPTIPLEX-XE-SV mynetwork.net Internet

(This computer)

View your active networks Connect or disconnect

= twork.net Access Internet
I *_' r:]yne wol. ne Connections: [ Instrument - Motherboard
Work network L NIC

Change your networking settings

See also i Set up a new connection or network
Ak i NetSession Interf = Set up a wireless, broadband, dial-up, ad hoc, or VPN connection; or set up a router or access
amai ession Interface

oint.
Control Panel P
HomeGroup W Connectto a network
-
Internet Options Connect or reconnect to a wireless, wired, dial-up, or VPN network connection.

» Computers running a full version of GeneMapper® ID-X Software (contains
the database): Export the data objects or settings you would like to restore after
upgrade (analyzed projects, analysis methods, plot settings, etc.). For information,
refer to the GeneMapper® ID-X Software online help.

e Computers running a client version of GeneMapper® ID-X Software: Export is
not required.

¢ Computers running GeneMapper ID Software v3.2: Do not export at this time.
You will be prompted to export during the installation.

Uninstall GeneMapper® ID-X Software, any other programs that use Oracle databases,
and any existing versions of Oracle databases, whether Life Technologies products or
products from other companies. Go to Start » Control Panel » Add or Remove
Programs.
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Check virtual
memory settings

After uninstallation, ensure that the GeneMapper® ID-X Software is uninstalled (go to
Start » Control Panel » Add or Remove Programs and make sure it is not listed.

If it is still listed, manually uninstall the software (see “If the GeneMapper® ID-X
Software is still listed after uninstalling (tested on Windows® XP only)” on page 38).

1. On the desktop, right-click My Computer, then click Advanced System Settings.

(=[O el

—~——

Control Panel Home

'E‘:;' Device Manager
'E‘:;' Remote settings

'E‘:;' System protection

I Advanced system settings

See also
Action Center
Windows Update

Performance Information and
Tools

or s |;5.i v Control Panel » All Control Panel Items » Systermn

View basic information about your computer

Windows edition

Windows 7 Professional
Copyright @ 2009 Microsoft Corporation. All rights reserved.

Service Packl
Get more features with a new edition of Windows 7

System
Manufacturer: Dell
Model: Optiplex XE
Rating: 2551l Windows Experience Index
Processor: Intel(R) Core(TM)2 Due CPU  E8400 @ 3.00GHz 3.00 GHz
Installed memory (RAM): 400 GB (3.25 GB usable)
Systemn type: 32-bit Operating System
Pen and Touch: MNe Pen or Touch Input is available for this Display
Dell support
Website: Online support

Computer name, domain, and workgroup settings

Computer name: OPTIPLEX-XE-5V

Full computer name: OPTIPLEX-XE-5V

Computer description: Optiplex XE Series Instrument & Application Computer
Workgroup: WORKGROUP

- | 5 | | Search Control Pansl O l

@ -

m

[y Change settings

GeneMapper® ID-X Software Version 1.4 User Bulletin
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2. In the System Properties dialog box, click Settings in the Performance section.

Systern Properties @
Computer Mame Advanced | Spstem Protection | Remaote

“Y'ou musgt be logged on as an Administrator to make most of these changes.

Perfarmance

Wisual effects, processor scheduling, memary usage, and virtual memany

Settings...

Uszer Profiles

Desklop settings related to your logon

Startup and Recovery

Sustem startup, system failure, and debugging information

Settings...
Environment ' ariables...

[ QK ][ Cancel ] Apply

3. Click the Advanced tab, then click Change in the Virtual Memory section.

Performance Cptions @

| Visual Effects | Advanced |Data Execution Preventi0n|

Processor scheduling

Choose how ko allocate processor resources,
Adjust For best performance of

@) Programs () Background services

Wirkual memary

A paging file is an area on the hard disk that Windows uses as

if it were RAM,
Tatal paging file size for all drives: 3325 MB
[ OF ] [ Cancel ] Apply

4. In the Virtual Memory dialog box, deselect the Automatically Manage paging file
size for all drives check box. Select the C: drive. Click the Custom size radio
button. Specify 2046 MB for initial and 4092 for maximum size.

IMPORTANT! The exact Maximum Size necessary may depend on your computer
configuration. If installation still fails when using these values, or if Oracle®
ORA-12528 and ORA-12541 errors are displayed, increase the Maximum size to at
least 2X the physical memory (the minimum required for the installation of
Oracle® software) up to the value shown for Space Available, then repeat the
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installation. To determine the physical memory for your computer, right-click My
Computer on the desktop, select Properties, then look for the RAM value on the
General tab. Example: If the physical memory is 3.0 GB RAM, set the Maximum

Size to 6000.
Wirtual Memory @
|| Automatically manage paging file size for all drives
Paging FleZzeforeachrdriv
Drive [Volume Label Paging File Size {ME)
D [ABSW &DATA] Mone
5 [AB Service] Mone
Selected drive: C: [05]

Initial size (MB): 2046

airmum size (ME): | 4092]

() Mo paging file

Tatal paging file size For all drives
Minimurn allowed: 16 MB
Recommended: 4937 MB
Currently allocated: 3325 MB

[ Ok ] [ Cancel

5. Click Set, then click OK.

These settings are not activated until you restart the computer.
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Check notification 1. Select @ » Control Panel » User Accounts. Click Change User Account

2. Inthe User Account Control Settings, drag the slider to the bottom position Never
Notify.

5' User Account Control Settings [ =

Choose when to be notified about changes to your computer

User Account Centrol helps prevent potentially harmful programs from making changes to your computer,
iTell me more about User Account Control settings

Always notify

Never notify me when:

®  Programs try to install software or make changes to
my computer

*®  Imake changes to Windows settings

@@ Mot recommended. Choose this only if you need to
use programs that are not certified for Windows 7
e because they do not support User Account Control,

Mever notify

Check Microsoft Ensure that a version of 2.0 or later is installed on the computer:
.NET Framework

i 1. Select € » Control Panel » User Programs and Features.
version

2. Scroll down and determine if a version of 2.0 or later is installed. (There may be
multiple versions installed. Do not remove any versions of the software.)

——
oot |E’L v Control Panel » All Control Panel Iterms » Programs and Features

Control Panel Home :
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and ther
) Turn Windows features on or
off :
Organize «

.
MNarme

=

5 Microsoft NET Frarnewark 4 Client Profile Vi . 20
Microsoft MET Framework 4 Extended ,erswn, : Or,
[2] Microsoft MET Framework 4 Multi-Targeting Pack hlgher 1S reqUIred

3. If a version of 2.0 or later is not installed, insert the v1.4 Full installation or Full
Upgrade DVD in the DVD drive. Navigate to the \ DotNet directory, then
double-click NETFx20SP2_x86.exe to launch the Microsoft NET Framework 2.0
Service Pack 2 (SP2) installer.

4. Read and accept the end user licensing agreement, then click Install.
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5. After installation completes, verify the Microsoft .NET Framework 2.0 SP2 was
successfully installed (select @9 » Control Panel » User Programs and Features).

Q\;/- |E’L v Control Panel » All Control Panel Iterms » Programs and Features

Control Panel Home :
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and ther

) Turn Windows features on or

et Organize «

Marme :

L?‘-Microsoft MET Framewark 4 Client Profile

L-?‘-Microsoft MET Framewark 4 Extended

[ Microsaft MET Framewark 4 Multi-Targeting Pack
Restart the To activate the changes made in the previous sections, restart the computer before
computer and installing the software.
recheck virtual After the computer restarts, follow the procedure in “Check virtual memory settings”
memory settings on page 23 and ensure that the new settings are activated.
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Installing GeneMapper® ID-X Software v1.4

General
installation
instructions
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IMPORTANT! If you use a computer platform that does not meet the requirements
listed in “Computer requirements” on page 12, you may experience difficulties during
installation (new or upgrade) of GeneMapper® ID-X Software, or the software may not
function properly, even if the installation proceeded successfully. Review the list of
recommended software operating systems included in the GeneMapper® ID-X
Software v1.4 Release Notes (see page 4) before beginning installation, and report any
issues encountered during installation to HID Technical Support (see page 5).

Before installing the GeneMapper® ID-X Software:

* Review “Computer requirements” on page 12, the GeneMapper® ID-X Software
v1.4 Release Notes (see page 4), the GeneMapper® ID-X Software Version 1.2
Installation Guide, and any supplemental documentation (see page 4).

* Log in to the local computer and have Administrator privileges when installing,
un-installing, or upgrading the GeneMapper® ID-X Software. Logging in to a
network domain with administrative privileges is not sufficient.

* During installation (new or upgrade) of GeneMapper® ID-X Software:

— Install the Full version first, then install all Client versions which will
connect to the Full version database.

— Allow the installation DVD to Autostart, or double-click the Setup.exe file to
launch the installer.

*  When un-installing the GeneMapper® ID-X Software, log in using the same local
user account as the one used when installing the software and follow the un-
installation message prompts during the un-installation process to ensure clean
un-installation.
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Software
installation

Use the GeneMapper® ID-X Software v1.4 Full or Client installation DVD for new installations or installations to

computers installed with GeneMapper® ID Software v3.2. A detailed description of different installation scenarios and

steps performed by the user is summarized in Table 2 and Table 3.

Table 2 Full installation scenarios and steps

Installation Type Scenario Choose DVD Steps

GeneMapper® /D- | Full installation Stand Alone Computer GeneMapper® . Log in to the local computer (not a network domain) using
X Software Full without any version of ID-X Software an account with Administrator privileges.

installation GeneMapper® /D-X v1.4 Full

Software or Data Collection
Software installed

Part no. 4479707

. Insert the GeneMapper® /D-X Software v1.4 Full DVD and

follow the instructions.
Installation may take up to 1 hour to complete.

. Enter the Registration Code to launch the software.

Full installation to a | Stand Alone Computer
computer installed with GeneMapper® /D
with GeneMapper® Software v3.2.x installed
ID Software v3.2

GeneMapper®
ID-X Software
v1.4 Full

Part no. 4479707

. Log in to the local computer (not a network domain) using

an account with Administrator privileges.

. Insert the GeneMapper® /D-X Software v1.4 Full DVD and

follow the instructions.
The software detects the GeneMapper® /D Software v3.X.

. When prompted, export the GeneMapper® /D Software v3.2

data objects or settings you would like to restore after
installation (analyzed projects, analysis methods, etc.) using
the export utility located on the Full or Full Upgrade DVD.

. Un-install the GeneMapper® /D Software v3.2 (go to the

Windows® Control Panel, then select Add or Remove
Programs).

. Restart the computer, then log in to the local computer

using an account with Administrator privileges.

. Install the GeneMapper® /D-X Software v1.4 Full version

from the Full DVD.
Installation may take up to 1 hour to complete.

. Enter the Registration Code to launch the software.
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Table 3 Client installation scenarios and steps

Installation Type

Scenario

Choose DVD

Steps

GeneMapper® /D-
X Software Client
installation

Client installation

Stand Alone Computer
without any version of
GeneMapper® /D-X
Software installed

GeneMapper®
ID-X Software
vl.4

1-Client

Part no. 4479711
5-Client

Part no. 4479708
10-Client

Part no. 4479709

1. Before installing, perform the procedures in the section
appropriate for the computer:

e “Procedures to perform before installation: Windows®
XP Operating System (0S)” on page 13.

 “Procedures to perform before installation: Windows® 7
Operating System (0S])” on page 20.
2. Install a full version of the software before the client version
(see Table 2 on page 29).

3. Log in to the local computer (not a network domain) using
an account with Administrator privileges.

4. Insert the GeneMapper® ID-X Software v1.4 Client DVD and
follow the instructions.

Installation takes about 15 minutes to complete.

5. Enter the Registration Code to launch the software.

7' LA 31BMYOS X-Q| gloddeauag bunmelsu)
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Installation Type

Scenario

Choose DVD

Steps

GeneMapper® /D-
X Software Client
installation

Stand Alone Computer
with GeneMapper® /D
Software v3.2.x installed

Client installation to
a computer with
GeneMapper® /D
Software v3.2

GeneMapper®
ID-X Software
v1.4

1-Client
Part no. 4479708

5-Client
Part no. 4479708

10-Client
Part no. 4479709

. Before installing, perform the procedures in the section

appropriate for the computer:
e “Procedures to perform before installation: Windows®
XP Operating System (0S)” on page 13.

e “Procedures to perform before installation: Windows® 7
Operating System (0S)” on page 20.

. Log in to the local computer (not a network domain) using

an account with Administrator privileges.

. Insert the GeneMapper® /D-X Software v1.4 Full DVD and

export the GeneMapper® /D Software v3.2 data objects or
settings you would like to restore after installation (analyzed
projects, analysis methods, plot settings, etc.) using the
export utility located on the Full DVD.

. Un-install the GeneMapper® /D Software v3.2 (go to the

Windows® Control Panel, then select Add or Remove
Programs).

. Restart the computer, then log in to the local computer

using an account with Administrator privileges.

. Insert the GeneMapper® /D-X Software v1.4 Client DVD and

follow the instructions.
Installation takes about 15 minutes to complete.

. Enter the Registration Code to launch the software.

7' LA 31BMYOS X-Q| gloddeauag bunmelsu)



Installing GeneMapper® ID-X Software v1.4

Upgrade from a
previous version of
GeneMapper® ID-X
Software

32

Note the following:

* Before upgrading the software, close all instances of previous versions of
GeneMapper® ID-X Software (on both Client and Full computers), and close all
other software programs and open windows.

* You need two registration codes:

— During the upgrade, the installer will prompt for the registration code for the
previously installed version of GeneMapper® ID-X Software.

— After upgrading to v1.4 and launching the software for the first time, enter
the new registration code provided with version 1.4.

* The data exported from previous versions of the GeneMapper® ID-X Software
can be imported and viewed in GeneMapper® ID-X Software v1.4.

A detailed description of different upgrade scenarios and steps performed by the user
is summarized in Table 4 and Table 5.

GeneMapper® ID-X Software Version 1.4 User Bulletin
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Table 4 Full upgrade scenarios and steps

Installation Type

Scenario

Choose DVD

Steps

Upgrade to
GeneMapper® /D-X
Software Full
installation

Upgrade GeneMapper® /D-X
Software v1.0.1 or later Full
install on a stand-alone
computer

GeneMapper® /D-X
Software Version 1.4
Full Upgrade

Part no. 4479715

. Before installing, perform the procedures in the section appropriate

for the computer:

e “Procedures to perform before installation: Windows® XP
Operating System (0S)” on page 13.

e “Procedures to perform before installation: Windows® 7 Operating
System (0S])” on page 20.

. Log in to the local computer using an account with Administrator

privileges.

. Insert the GeneMapper® /D-X Software Full Upgrade DVD and follow

the instructions.

. Enter the Registration Code from the previous version of software.

(The software will prompt you to enter the Registration Code from the
new version when you launch the software for the first time.)




L Table 5 Client upgrade scenarios and steps

Installation Type Scenario Choose DVD Steps
Upgrade to Upgrade GeneMapper® /D-X GeneMapper® /D-X 1. Before installing, perform the procedures in the section appropriate
GeneMapper® /D-X Software v1.0.1 or later Client Software Version 1.4 for the computer:
Software Client installed on a stand-alone Client Upgrade e “Procedures to perform before installation: Windows® XP
computer Part no. 4479710 Operating System (0S])” on page 13.

e “Procedures to perform before installation: Windows® 7 Operating
System (0S)” on page 20.

2. Upgrade a full version of the software before the client version (see
Table 4 on page 33).

3. Log in to the local computer using an account with Administrator
privileges.

4. Insert the GeneMapper® /D-X Software Client Upgrade DVD and
follow the instructions.
The software detects the previous version of GeneMapper® /D-X
Software.

5. Enter the Registration Code from the previous version of software.
(The software will prompt you to enter the Registration Code from the
new version when you launch the software for the first time.)

Procedures to perform after installation

Reset file and The client installer specifies folder privileges at the time of the GeneMapper® ID-X Software installation.

folder. perm|s§ IONS  However, the NTFS permissions set by the system administrator may not allow the GeneMapper® ID-X Software to
after installation access the GeneMapper folder following installation. Before you run the software, check the permissions to make sure
(Client installation)  that the GeneMapper® ID-X Software can access the GeneMapper folder.

If you do not have the required permissions, you may see a “can't access file” or “..\ GeneMapper_Preferences (Access is
denied)” error message when using the software. To set the privileges manually, either before running the software or in
the event of an error message:

1. Right-click the AppliedBiosystems folder.
2. Select Properties, then click the Security tab.

3. In the top pane, select Users.

unayng J4asM ¥°| UoIsia) a1emyos x-qj gladdepausg
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Reset antivirus,
firewall, and
network computer
settings

Import
GlobalFiler™
stutter files

Obtain and run the
HID Updater on
3500 Series
instruments

4. Windows 7 OS only: Click Edit.

5. In the bottom pane, select Full Control.

Windows® XP 0S

Local Disk (C:) Properties

General | Tooks | Hardware | Sharing | Security | Quota

Group or user hames:
!ﬁ Adminiztrators [FRMYREELAMMLOE ADministrators]
€7 CREATOR DWNER
!ﬁ Everyone
€7 SYSTEM
[ ¢ Users [FRMYREELAMMLOEN sers)

Permissions for Users

Allow
Full Cantral
Madify
Read & Execute
List Folder Contents
Read
write

Crmmiad Dmrrninnioane

For special permissions of for advanced settings,
click Advanced.

[ QK H Cancel ][ Apply

]

Windows® 7 0S

| Applied Biosystemns Properties @
General | Sharing | Security | Previous Versions Eustomize|
Object name:  C:\Applied Biozystems
Group or user names:
5, Authenticated Users
5L SYSTEM
‘R}Administrators [OPTIPLER-<E-S%" Administrators]
93, Uszers [OPTIPLEX-XE-S%\U zers)
Ta change permizsions, click Edit.
Permizzions for Uzers Allow Deny
Full cantral v it
Madify v
Read & execute =
Lizt folder contents
Read
"wirite i 2
For special permissions or advanced settings,
click Advanced.
Leam about sccess control and permissions
[ QK ] [ Cancel ] Apply

Reset the antivirus, firewall, and network settings you changed for installation.

Import the stutter files provided with the software into the GeneMapper® ID-X
Software database. See the GeneMapper® ID-X Software online help for information.

You can run 6-dye samples on 3500 Data Collection Software v1 or v2. Before running
on either system for the first time, run the HID Updater 3500 DC v2.0

(Part no. 4480670). The HID Updater installs the plate templates, assays, and
instrument protocols needed to run GlobalFiler'" Kit samples. For more information,
refer to the release notes provided with the Updater.

Note: If you have a new instrument installed by a Life Technologies representative, the
updater may have been run during installation.

1. Obtain the HID Updater 3500 DC v2.0 from www.lifetechnologies.com/
support » Software, Patches & Updates » 3500 Series Genetic Analyzers for

Human Identification.

o M DN

GeneMapper® ID-X Software Version 1.4 User Bulletin

Exit the 3500/3500xL Data Collection Software.
Load the HID Updater Installer CD on the instrument computer.
Double click the HID_Updater_3500_DC_SW_2.0.exe file on the CD.

When installation is complete, restart the computer.
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Troubleshooting

Troubleshooting

Symptoms and
causes

Symptom

Possible cause

Action

ORA-12528 and ORA-12541 Oracle®
errors displayed during installation

Problem with Oracle® software
installation.

AWINDOWS\system32\cmd.exe

SQL=Plus: Release 11.2.8.1.8 Production on Thu May 17 14:19:19 2812

Copyright (c> 1982, 2818, Oracle.

[ERROR :
ORA—12528: THS:listener: all appropr

All rights reserved.

te instances are blocking new connections

\WINDOWS Y system32\.cmd.exe

Enter user—name:

SOLxPlus: Release 11.2.0.1.8 Production on Wed May 2 12:01:16 2012

Copyright (c) 1982, 2010, Oracle.

: TNS:no listener

lEnter user-name:
|

All rights reserved.

Contact Life Technologies.

“GeneMapper® ID-X software requires
Microsoft .NET Framework 2.0 or
greater. You can download from
Microsoft or run the .NET setup
included in the DVD to install it.”

Incorrect Microsoft® .NET Framework
version

1. Cancel the installation.

2. Install the required version. See
“Check Microsoft .NET Framework
version” on page 18.

3. Start the installation again.

GeneMapper® ID-X Software will not
start after installation

“No databases found” message

Uninstallation of the previous version

of GeneMapper® /D-X Software failed.

Note: In most cases, uninstallation
should succeed. However, third-party
software, firewall interference, and
other situations may interfere with
successful uninstallation.

Network security settings are
preventing communication between
the user interface and the Oracle®
database.

Uninstall the software. See “Uninstall
the GeneMapper® ID-X Software” on
page 38.

If the problem persists, contact Life
Technologies.

Modify network security settings. See
“Enable communication with port 1521
Windows® XP 0S” on page 39 or
“Enable communication with port 1521
Windows® 7 0S” on page 39.

Virtual network adapters are enabled.

Disable virtual network adapters.

If the problem persists, contact Life
Technologies.

36
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Symptom

Possible cause

Action

“The database connection has been
lost. Please restart the application.
This message may appear multiple
times.” message

Full installation regularly loses
connection with the database

Network communication is
interrupted.

Restart the software.

Restart Oracle services (see “Restart
Oracle services” on page 43).

Wireless network in use.

Anti-virus software is interfering with
communication.

Unstable network connections.

Use a cable-based network system,
such as a CAT5e network, with plug-in
Network Interface Controller (NIC)
cards.

Use less restrictive anti-virus settings.

Disable, replace, or remove the anti-
virus software.

Use a cable-based network system,
such as a CATb5e network, with plug-in
Network Interface Controller (NIC)
cards.

Contact your network administrator.

Use a cable-based network system,
such as a CAT5e network, with plug-in
Network Interface Controller (NIC)
cards.

Client installation “cannot access file”
or “.\GeneMapper_Preferences
(Access is denied)” message

File and folder permissions are not set
correctly on the client computer.

Set permissions. See “Reset file and
folder permissions after installation
(Client installation)” on page 34.

Client installation regularly loses
connection with the database, but full
installation does not lose connection

Disk space message is displayed when
you start the software

Version error displayed when you
import a panel file (this message
differs from the message displayed in
earlier versions of the software)

GeneMapper® ID-X Error

i

'0' ‘Version' incorrect or missing. Offending line #1

Unstable network connections.

The computer has limited available
disk space.

The version text in the panel .txt file is
not present.

% AmpFLSTR_Panels_v3X.txt - Notepad

version GMID-X v 1.4
L = MICRTSATELLITE

Chemistry Kit  AMpFLSTR_Panels_w3x
Panel Profiler_wl.2x null

Contact your network administrator.

If possible, archive then delete data
from the database.

Use the Database Dashboard utility to
compress the database.

Note: You may see a discrepancy
between the space used in the
Database Dashboard » GeneMapper
IDX » Projects Statistics and the
available free space. This discrepancy
is caused when you delete projects
from the GeneMapper® /D-X Software.

Edit the panel .txt file to include the
text shown in the figure.

GeneMapper® ID-X Software Version 1.4 User Bulletin

37



Troubleshooting

Symptom

Possible cause

Action

Cannot access deleted audit records

Restore the audit records.

1. In the Project window, select
Admin » Audit Manager » Report.

2. Log in to the Audit Manager.

3. In the Audit History Viewer,
File » Edit Query, leave the default
settings, then click OK.

4. Select File » Execute Query.

Small markers and low molecular
weight microvariant alleles are not
displayed in plots when using the
default 6-dye plot setting

The 6-dye plot setting starts at 75 bp.
However, the smallest markers in the
GlobalFiler™ Express Kit and low

molecular weight microvariant alleles

Edit plot settings to decrease the
starting size range (for example, to
60 bp) to ensure all alleles are
displayed in plots.

may fall below 75 bp.

Uninstall the 1.
GeneMapper® ID-X
Software 2

Restart the computer and log on using a local computer administrator account
(see “Check user access” on page 13 or page 20).

. Ensure that no programs or applications are running.

3. Disable any antivirus software (including antimalware software).

4. Select @) » Control Panel » Uninstall a Program. Select GeneMapper® ID-X
Software, then click Uninstall.

5. Restart the computer and log on using a local computer administrator account.

6. Confirm that the software has been uninstalled: select € » Control
Panel » Uninstall a Program. If GeneMapper® ID-X Software is still listed, go to
“If the GeneMapper® ID-X Software is still listed after uninstalling (tested on
Windows® XP only)” below.

If the 1.
GeneMapper® ID-X
Software is still
listed after
uninstalling (tested
on Windows® XP

Ensure antivirus/antimalware software is disabled.

Note: In some instances, the antivirus/antimalware software is automatically
enabled, so you must ensure it is disabled more than one time in the procedure.

2. Confirm the Virtual Memory settings are correct (“Check virtual memory
settings” on page 15).

3. Run the Remove Oracle utility:

Insert the GeneMapper® ID-X Software Full or Full Upgrade Installation
DVD in the computer DVD drive, right-click on the drive icon, then select
Explore.

. Navigate to Utilities » RemoveOracle.exe.

Copy RemoveOracle.exe to the desktop.

. Double-click RemoveOracle.exe (a black box appears for a few seconds and

disappears).

4. Navigate to and delete the entire x:\AppliedBiosystems folder.

5. Restart the computer and log on using a local computer administrator account.

only)
a.
b
C.
d
38
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Enable
communication
with port 1521
Windows® XP 0S

Enable
communication
with port 1521
Windows® 7 0S

The GeneMapper® ID-X Software uses port 1521 to communicate between the user
interface and the Oracle database via the TCP Internet Protocol and TNS Names. On
most computers, this port is enabled automatically during installation.

However, if the software does not start or a “No databases found” message is
displayed after installation, modify settings to enable communication with port 1521.

IMPORTANT! In addition to Windows security settings, some third-party anti-virus or
firewall applications may affect port 1521. If you are running, third-party anti-virus or
firewall applications, modify settings for those applications to enable communication

with port 1521.

1. Log on to the computer using a local computer administrator account (see “Check
user access” on page 13).

2. Select Start » Network connections. Right-click Local Area Connection, select
Properties, click Advanced, then click Settings.

3. If the Windows Firewall is on, click Exceptions, click Add Program, then select
GeneMapper® ID-X Software.

The GeneMapper® ID-X Software uses port 1521 to communicate between the user
interface and the Oracle database via the TCP Internet Protocol and TNS Names. On
most computers, this port is enabled automatically during installation.

However, if the software does not start or a “No databases found” message is
displayed after installation, modify settings to enable communication with port 1521.

IMPORTANT! In addition to Windows security settings, some third-party anti-virus or
firewall applications may affect port 1521. If you are running, third-party anti-virus or
firewall applications, modify settings for those applications to enable communication

with port 1521.
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Troubleshooting

1. Select €) » Control Panel » Security » Windows Firewall. Click Advanced
Settings.

[E=N Nl

@@v|ﬁ v Control Panel » All Contral Panel Iterns  » Windows Firewall - | 3 | | fearch Controf Panel 0O |

)

Control Panel H ; g :
. Help protect your computer with Windows Firewall

Allow a pregram or feature Windows Firewall can help prevent hackers or malicious software from gaining access to your computer

through Windows Firewall through the Internet or a network.
% Change notification settings How does a firewall help protect my computer?
#) Turn Windows Firewall on or What are network locations?

off

Update your Firewall settings

Windows Firewall is not using the recommended

g [ %] Use recommended settings
settings to protect your computer.

What are the recommended settings?

. @' Home or work (private) networks Connected "

MNetworks at home or work where you know and trust the people and devices on the network

Windows Firewall state: Off

Incoming connections: Block all connections to programs that are not on the
list of allowed programs

Active home or work (private) networks: L:B applera.net

Motification state: Notify me when Windows Firewall blocks a new
program

&3 Public networks Not Connected (%)
See also il

Action Center

MNetwork and Sharing Center

2. In the Windows Firewall with Advanced Security window, click Inbound Rules.

& Windows Firewall with Advanced Security EI@

File Action ‘iew Help

& i AU E Rl Windows Firewall with Advanced Security on L... JiEf Y
Outbound Rules
®u Connection Secur

| Windowws Firewall with Advanced Security on Local Computer -

ﬂ Wwindows Firewall with Advanced Security ¢ &) Import Policy..

. B Monitaring —| | 42| ExportPolicy...

Onverview Restore Default Policy
Domain Profile

Diagnose f Repair
@ windows Firewal is on.

Wigan »
G Inbound connections that do not match a il
— |G Refresh
@ Outbound cormections that do not mateh a
D Properties
Private Profile is Active
E Help

B windaws Firewall is aff.

Public Profile

4 windows Firewall is off. -
4 i N i b
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3. Click New Rule.

& Windows Firewall with Advanced Security
File Action ‘iew Help

== 7E = H

&3 Inbound Rules

EY Outbound Rules
& Connection Secur @Akamai MetSession Interface

» Bl Manitaring @Akamai MetSession Interface
@Akamai MetSession Interface
@Akamai MetSession Interface
@ CyberlLink PowerDVD DX

Marme

@ocom

aGeneMapperID)(

@HP BPT Rernote Agent

@HP BPT Rernote Agent

@Microsoft Office Qutlook
aBranchCache Content Retrieval (HTTP-In)
@ EranchCache Hosted Cache Server (HTT,

@CyberLink PowverDtD DX Resident Progra...

B Windows Firewall with BTN TG Actions

-

I

14;3
s
g
g

Mewr Rule..
ilter by Profile
Filter by State
Filter by Group
Wigan

|G Refresh
|5+ ExportList..

E Help

v v v w

4. Select Port, then click Next.

0 Mew Inbound Rule Wizard

Rule Type

Select the type of firewall rule to create.

Steps:

Fratocol and Ports
@ Action ) Program
@ Profile

@ Mame

() Custom
Custom rule.

@ PRule Type Wwhat type of rule would you like to create?

BranchCache - Content Retrieval [Jses HTTF]

Fiule that controls connections for a Windows experience.

Fiule that controls connections for a TCP or UDP port.

< Back

[

Mewt >

J |

Cancel

]

5. Select TCP, then type 1521 in the Specific Local Ports, then click Next.

ﬂ MNew Inbound Rule Wizard
Protocol and Ports

Specify the protocols and ports to which thiz rule applies.

Steps:

Protocol and Ports

Action

Frafile

@ Mame

) All local po

@ Specific local ports: 1521

Fiule Type Does this rule apply to TCP or UDP?

Does this rule apply to all local ports or specific local ports?

T80, 443, 5000-5010

==

< Back

I

Mewt >

J |

Cancel
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Troubleshooting

42

6. In the Action page, select Allow the connection, then click Next.

9 Mew Inbound Rule Wizard
Action

Specify the action to be taken when a connection matches the conditions specified in the wle.

Steps:

Rule Type ‘what action should be taken when a connection matches the specified conditions?

Fratocol and Ports

@ Allow the connection

- GElim Thiz includes connections that are protected with IPzec az well az those are not,
»  Profile

Allow the connechion
@ Mame

Thiz includes only connections that have been authenticated by uzing IPsec. Connections
will be gecured using the settings in IPsec properties and rules in the Connection Security
Rule node.

Block the connection

I < Back |[ Mext > ] | Cancel

7. In the Profile page, leave the default settings selected, then click Next.

9 Mew Inbound Rule Wizard
Profile

Specify the profiles for which this rule applies.

Steps:
s Flule Type ‘wihen does this rule apply?

@ Protocol and Ports

& Action [¥] Domain
y Profile Applies when a computer is connected to its corporate domain.
@ Mame [¥] Private

Applies when a computer iz connected to a private network location,
[¥] Public

Applies when a computer iz connected to a public network, location.

[ < Back | | Mext > | [ Cancel

8. In the Name page, type GeneMapper IDX, then click Finish.

ﬂ Mew Inbound Rule Wizard
Name

Specify the name and description of this rule.

Steps:

Fiule Type

Fratocol and Ports

»  Action

5 Profil e
Genekdapper D%

» Mame

Deszcription [optional]:

< Back I [ FEinigh ] I Cancel
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The Inbound Rules List is displayed with GeneMapper IDX added as a rule. The
rule should be enabled by default (indicated by the presence of the Disable Rule

command).

& Windows Firewall with Advanced Security
File Action ‘iew Help

o= | #nE = HE

B Windows Firewall with BTN TG

&3 Inbound Rules
EY Outbound Rules
H% Connection Secur

Marme

'@'GeneMapperID){
. B Manitaring Akamai MetSession Interface
Akamai NetSession Interface
Akamai NetSession Interface
Akamai NetSession Interface

CyberLink PowerDWD DX

DCOM
'ﬁ'GeneMapperID){

HP BPT Remote Agent
HP BPT Remote Agent
Microsoft Office Outlook

'ﬁ'BranchCache Content Retrieval (HTTP-In)

¥ TR ~ A
4 10 2 4 10

9. If Enable Rule is displayed instead of Disable Rule, click Enable Rule.

Restart Oracle

services services using a .bat file or manually.

Restarting with a .bat file

CyberLink PowerDWD DX Resident Progra...

L=

Actions

+ || Inbound Rules
Mew Rule..,
Filter by Profile
Filter by State

440

Filter by Group
Wigan

Refresh

|5+ ExportList..

Genebdapper IDX

Hel

# Disable Rule

If a “The database connection has been lost” message is displayed, restart Oracle

1. On the v1.4 Full, Demo, or Full Upgrade installer DVD, navigate to the Utilities

folder.

2. Double-click ServicesRestart.bat. (You can also copy the file to your hard disk
and start the .bat file from your hard drive.)

The following window is displayed for ~2 minutes as the services restart.

C:\WINDOWS\system32\cmd.exe

IC:~Documents and Settingsssail
The OraclelFAGMIDETNSListener ruice is
The OraclelFAGMIDETMSListener service wa

IC:~Documents and Settingsssail
The OracleMISRecoveryService service i
The OracleMISRecoveryService service w

IC:~Documents and Settingsssail
The OraclefServicelFA service is stopping

s \Desktop’net stop Oraclel FAGMIDHTHEListener

stopping.
stopped successfully.

'S\Des_ktop)netf stop OracleMTSRecoveryService

topping.
stopped successfully.

s“\Desktop’net stop OracleServicelFA

3. When the window closes, start the GeneMapper® ID-X Software.

GeneMapper® ID-X Software Version 1.4 User Bulletin
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Restarting manually

1. Go to Start » Control » Panel » Administrative Services » Services.

2. In the Services screen, right-click the following services, then select Restart:

OracleIFAGMIDXTNSListener

* OracleMTSRecoveryService

OracleServicelFA

Services (Local)

OracleIFAGMIDXTNSListener Name Description
%Neh\lnrk Access Protection Agent Allows win...

%Ds%.meﬁ::r;lc:'ice %Neh\'nrk Connections Man..ages Q..
%Neh\'nrk DDE Provides n...
%Neh\'nrk DDE DSDM Manages D...
%Neh\'nrk Location Awareness (MLA) Collects an...
%Neh\'urk Provisioning Service Manages X...
%N‘I’ LM Security Support Provider Provides s...
Bn02FLASH
%Ofﬁce Source Engine Saves inst..

racleMTSRecovery!
racleServicelFA
el Performance Logs an

Caollects pe.

Pl Driver HPZ 12 All Tasks b
%Purlab\e Media Serial Retrieves t...
Print Spooler Refresh Loads files ...
%Protected Storage Properties Provides pr...
%QOS RSYP Provides n...
%Remote Access Auto Help Createsa ...
%Remote Access Connection Manager Createsa ...
%Remote Diesktop Help Session Manager Manages a...
%Remote Procedure Call (RPC) Provides th...
%Remote Procedure Call (RPC) Locator Manages t...
%Remote Registry Enables re...

%Remmvahle Storage

%Plug and Flay Enablesac...

Status

Started

Started

Started

Started

Started
Started

Started
Started

Started

Started

Started

Started

Started

Startup Type
Manual
Manual
Digabled
Disabled
Manual
Manual
Manual
Automatic
Manual
Manual
Automatic
Disabled
Automatic

Automatic
Manual
Automatic
Automatic
Manual
Automatic
Automatic
Manual
Manual
Manual
Manual
Automatic
Manual
Automatic
Manual

Log On As

Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
Local System
MNetwork S...
Local System
Local Service
Local System
Local System
Local System
Local System
Local System
Local System
Local System
MNetwork S...
Network S...
Local Service
Local System

3. Ensure the Startup Type is set to Automatic for each service. If it is not, right-click

a service, then select Automatic for Startup Type.

OraclelFAGMIDXTNSListener Properties (Local Comput.

General |Log On || Recovery | Dependencies

Service name:  OraclelFAGMIDXTNSListener
Display name: OraclelFAGMIDXTNS Listener
Description:

Path to executable:
C:\AppliedBiosystems"OracleGMIDX\BINYTNSLSNR

Startup type: Automatic w

Service status:

You can specify the start parameters that apply when you start the service
from here.

[ QK ] [ Cancel Apply

4. Start the GeneMapper® ID-X Software.
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Test cases
performed

Table 6 Data collection software verification testing

Testing Categories Subcategories Test Description
3130/3730 Data Run setup, Activate 6-dye license (not required for 3500), perform spatial calibration,
Collection software instrument perform a spectral calibration with DS-33 and DS-36 Matrix standards, run
Vb control, and data samples processed with existing AmpF(STR® PCR Amplification Kit and the
. . ™ .
3500 Data Collection collection of 5-dye | GlobalFiler™ Express Kit.
Software v2 and 6-dye
samples.
3500 Data Collection - ) ) -
Software v1 Genotyping Evaluate genotyping concordance between new and earlier versions of Data
Collection Software.
Sizing precision Calculate sizing precision and size range per run for each instrument using
GlobalFiler™ Express Kit allelic ladder data.
Sensitivity Evaluate GlobalFiler™ Express Kit sample peak heights and allelic dropout

with 125 pg total DNA input.
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Table 7 GeneMapper® ID-X Software v1.4 verification testing

Testing Categories

Subcategories

Test Description

GeneMapper® ID-X
Software v1.4
testing with the
GlobalFiler™
Express Kit

Allelic ladder
genotyping

Sample
genotyping

e Compare the allelic ladder run sizing, genotyping, and PQV scoring
between v1.3 and v1.4 (without ACC).

¢ Visually inspect 20 allelic ladders from each instrument for proper allele
calling, PQV scoring, and PQV flagging.

¢ Compare the single-source (population) and positive control sample
allele calls:
- To corresponding allele calls generated with Identifiler®, NGM
SElect™, and Yfiler® Kits.
- Between instruments.

e Compare the single-source (population), positive control sample, and
sensitivity sample: sizing, genotyping, and PQV scoring between v1.3 and
v1.4 (without ACC).

GeneMapper® ID-X
Software v1.4
testing GlobalFiler™
Express Kit

Mixture Analysis

Evaluate for accurate results:
e MIT pruning and sample segregation.

e Pattern extraction, PHR, residual, Mx and Avg Mx calculation, and flags
and values.

¢ Individual data files for RMP, CPI, LR, and multiple-kit merging
calculations.

Concordance testing
of legacy kit data
with GeneMapper®
ID-X Software v1.3

Sizing and
genotyping

Mixture analysis

e Export Genotype and Sizing tables and compare peak heights, areas, data
points, sizes, allele names, and PQV scores.

e Compare the 310 matrix results.

Compare mixture analysis calculations and flags using the same analysis
methods and thresholds.

Verification of new
v1.4 software
features and

ACC and AN PQVs,
Y Marker check
box in Panel

e Process GlobalFiler™ Express Kit data with the GlobalFiler panel and
bins.

¢ Visually verify the accuracy of the ACC and AN flag results.

updates Manager (new)
Spike Detection Disable/enable sample spike detection and visually verify accuracy of SPK
disable/enable and GC flag results.
function for
samples (new)
SPK PQV results ¢ Confirm SPK flag is Check, * for any sample type where spike detection
(updates to N/A is enabled and a spike is present (including samples that contain a spike,
and Check Flag but do not contain true alleles).
rules) ¢ Confirm SPK flag is N/A for any sample type where spike detection is

disabled.
Define New Define New Sample Path function works for .hid files.
Sample Path
function
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Computers used

Table 8 Configuration of test computers

Computer Configuration

. Make/ Processor (CPU)/ Memory Operating System (0S)/
Testing Category Model Speed (RAM) Service Pack (SP)
Data Collection ®
Software v4 Dell ® Intel® Core™2 Duo E8400 Windows® 7 Professional 0S
: OptiPlex ” XE 3 GHz 4 Gb (SP1), 32-bit
3500 Data Collection (4 computers) '
Software v2
GeneMapper® ID-X Dell® Intel® Core™?2 Duo P8700 3.48 Gb Windows® 7 Professional 0S
Software v1.4 Latitude® E6500 2.53 GHz (SP1), 32-bit
Dell® " Intel® Core™2 Duo P8700 34806b  Windows® XP Professional 0S
Latitude® E6500 2.53 GHz (SP3), 32-bit
GeneMapper® ID-X Dell® Intel® Core™2 Duo E8400 4 Gb Windows® XP Professional 0S
Software v1.3 OptiPlex® XE 3 GHz (SP2), 32-bit
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Samples used for

concordance
testing

A total of 3149 sample files (.fsa and .hid) were used in the sizing and genotyping concordance test. These samples were

analyzed using both GeneMapper® ID-X Software versions 1.3 and 1.4. The Genotypes and Sizing tables were exported
and compared using Beyond Compare® Software version 3.2.4 to determine whether any differences in data output

resulted. The peak heights, peak areas, data points, sizes, allele names, and all the PQV scores were compared between
the two software versions.

Table 9 Number of sample files (.fsa and .hid) by type used in concordance testing. The CE instrument, Data Collection software version, and AmpF(STR® kit
used to generate data are noted.

Instrument/ AMBFISTR® | Single Low Good Low
Data Collection pre 9 Sensitivity | Mixture | Quality | LOR | OMR | Spike Quality | Positive | Negative | Total
Kit Source Ladder
Software DNA Ladder

310 Genetic COfiler® 16 6 5 12 — — — 8 — 1 1 49

Analyzer Profiler 16 6 6 12 - | = — 8 - 1 1 50

Data Collection Plus®

Software v3.0/3.1 —
Identifiler® 16 6 6 12 — — — 15 — 1 1 57
SGM Plus® 16 8 6 12 — — — 5 — 1 1 49
SEfiler™ 16 5 6 12 — — — 5 — 1 1 46
Yfiler® 80 — — — — — — 6 — 1 1 88
MiniFiler™ 30 — — — — — — 7 — 1 1 39

3100 Genetic COfiler® 16 6 6 12 — — — 3 — 1 1 45

Analyzer Profiler 16 6 6 12 - | = — 3 - 1 1 45

Data Collection Plus®

Soft 1.1/2.0

oftware VI.1/20 7 1 ifiler® 16 6 6 12 — | = — 3 — 1 1 45

SGM Plus® 16 6 6 12 — — — 3 — 1 1 45
SEfiler™ 16 6 6 12 — — — 3 — 1 1 45

3100-Avant™ COfiler® 16 6 6 12 — — — 3 — 1 1 45

Genetic Analyzer o o 16 6 6 12 - | = — 3 - 1 1 45

Data Collection Plus®

Software v2 . T
Identifiler® 16 6 6 12 — — — 3 — 1 1 45
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Instrument/ ® . Low Low
Data Collection Amth_STR Single Sensitivity | Mixture | Quality | LOR | OMR | Spike Good Quality | Positive | Negative | Total
Kit Source Ladder
Software DNA Ladder

3130x( Genetic Profiler — — — — — — — 48 — — — 48

Analyzer Plus®

Data Collection Identifiler® 93 24 12 30 12 10 9 48 58 1 1 298

Soft 3.0

orware v SGM Plus® - _ _ - | - | = 32 _ - — 32

SEfiler™ — — — — — — — 16 — — — 16
Yfiler® 10 — 2 — — — 16 32 — 1 1 62
MiniFiler™ 10 — 2 — — — — 32 — 1 1 46
Sinofiler™ 113 36 14 — — — — 48 — — 6 217
NGM SElect™ 100 — — — — — — 12 — — — 12
Express

3130x( Genetic Yfiler® — — — — — — — 48 — 45 3 96

Analyzer ™

Data Collection NGM SElect — — — — — — — 48 — 45 3 96

Software v3.1.1

3730 DNA Identifiler® 90 48 — — — — — 48 — 1 1 188

Analyzer

Data Collection

Software v3.0

3730 DNA Identifiler® — — — — — — — 48 — 45 3 96

Analyzer

Data Collection

Software v3.1.1

3130x{ Genetic SGM Plus® 60 — — — — — — 12 — 12 12 96

Analyzer Identifiler® 60 - — — — — — 12 - 12 12 96

Data Collection Pl

Software v4 us
Yfiler® 60 — — — — — — 12 — 12 12 96
NGM™ SElect 60 — — — — — — 12 — 12 12 96
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Instrument/ ® . Low Low
Data Collection Amth_STR Single Sensitivity | Mixture | Quality | LOR | OMR | Spike Good Quality | Positive | Negative | Total
Kit Source Ladder
Software DNA Ladder
3730 DNA Identifiler® 60 — — — — — — 12 — 12 12 96
Analyzer
Data Collection
Software v4
3500xL Genetic Identifiler® 84 — — — — — — 12 — — — 96
Analyzer Plus
Data Collection | Identifiler® 84 — - - - - - 12 — - — 96
Software v1 Direct
NGM™ 84 — — — — — — 12 — — — 96
NGM SElect™ 52 — — — — — — 8 — — 4 b4
Express
3500xL Genetic SGM Plus® 60 — — — — — — 12 — 12 12 96
Analyzer Identifiler® 60 — — — — | = — 12 - 12 12 96
Data Collection Plus
Software v2 __
Identifiler® 60 — — — — — — 12 — 12 12 96
Direct
NGM SElect™ 60 — — — — — — 12 — 12 12 96
Total 1578 187 107 186 12 10 25 690 58 262 146 3149
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Samples used for
GlobalFiler™ Kit
Express
genotyping testing

A total of 1990 sample files (.fsa and .hid) were used in the sizing and genotyping
concordance test. These samples were analyzed using both GeneMapper® ID-X
Software versions 1.3 and 1.4. The Genotypes and Sizing tables were exported and
compared using Beyond Compare® Software version 3.2.4 to determine whether any
differences in data output resulted. The peak heights, peak areas, data points, sizes,
allele names, and all the PQV scores (except for ACC and AN) were compared
between the two software versions. The results for the sensitivity samples, allelic
ladders, positive and negative controls were also visually inspected for accuracy.

Table 10 Number of sample files (.fsa and .hid) by type used in GlobalFiler™ Express Kit testing. The CE instrument and Data
Collection software version used to generate data are noted.

Data Clonlfctart'::lil::r:éftware SS::]?'::ee Sensitivity Mixture I'_Aal:;l; Positive Negative Total
3130x! Genetic Analyzer 250 20 40 96 6 6 418
Data Collection Software v4
3730 DNA Analyzer 250 — — 192 6 6 454
Data Collection Software v4
3500xL Genetic Analyzer 250 20 - - 6 6 418
Data Collection Software v1
3500 Genetic Analyzer 250 20 40 96 6 6 418
Data Collection Software v2
3500xL Genetic Analyzer 250 20 40 96 6 6 282
Data Collection Software v2
Total 1250 80 120 480 30 30 1990

Samples used for
Spike enable/
disable testing

Samples used for
ACC and AN testing

Legacy samples
used for Mixture
analysis testing

* 64 data files with spikes generated with existing kits
* 45 data files with spikes generated with the GlobalFiler" Express Kit

The 80 sensitivity samples listed in Table 10 were visually inspected for ACC and AN
PQV result accuracy.

A historical mixture sample data set was used to verify the concordance of the mixture
analysis results between the GeneMapper® ID-X Software versions 1.3 and 1.4. The
data set included 2 contributor mixtures made from 8 pairs of genomic DNA samples
prepared in 11 mixture ratios: 1:0, 1:1, 1:2, 1:3, 1:5, 1:9, 9:1, 5:1, 3:1, 2:1, and 0:1. The 1:0
and 0:1 mixtures were used as 1 contributor (single-source) samples as well as the
known samples. The data set also included a sample with a 3 contributor mixture in a
mixture ratio of 1:1:2, and a sample triallelic for marker D75820. The mixture samples
were amplified with the AmpF/(STR® Identifiler® (1 ng and 0.125 ng), Profiler Plus®,
COfiler®, and SGM Plus® PCR amplification kits. The samples were collected from a
3130xI Genetic Analyzer.
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GlobalFiler™
Express samples
used for Mixture
Analysis

Data Collection
Software settings
used to run
GlobalFiler™
Express samples

52

The following mixture analysis features and number of sample files were tested:

* Mixture Interpretation Threshold (MIT) pruning and sample segregation testing —
467 sample files

¢ Pattern extraction comparison — 389 sample files
¢ Random Match Probability (RMP), Combined Probability of Inclusion/Exclusion

(CPI/CPE), and Likelihood Ratio (LR) calculations — 30 sample files

¢ Known matching — 60 sample files

* Multiple kit merging — 8 pairs of sample files

Mixture Analysis log files were generated from both software versions with the same
sample file sets.These files were compared using the Beyond Compare® Software

v3.2.4. The comparison tool lined up the text files from the two software versions, and
compared the file contents for concordance.

Sample Mixture DNA input | Contributor | Contributor
name Gender ratio ng:ng 1 (pL) 2(pL)
H15 H1 MM 0:1 0.0:0.1 0 10
H31 H30 FF 1:1 0.5:0.5 5 5
H3 H23 M F 1:2 0.33:0.67 3.3 6.7
H26 Hé M F 1:3 0.25:0.75 2.5 7.5
H20 H24 FF 1:5 0.17:0.83 1.7 8.3
1:7 0.125:0.875 1.25 8.75
1:9 0.1:0.9 1 9
1:0 1.0:0.0 10 0
Total — — — 24.5 55.25

Genetic Analyzer

Run modules and conditions

3500

HID36_POP4

Injection conditions: 1.2 kV/15 sec

Dye Set J6

3500xL

HID36_POP4xL

Injection conditions: 1.2 kV/24 sec

Dye Set J6

3130x!

HIDFragmentAnalysis36_POP4

Injection conditions: 3 kV/10 sec

Dye Set J6

3730

GeneMapper_36_POP7

Injection conditions: 2 kV/10 sec

Dye Set J6
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GeneMapper® ID-X
Software v1.4
analysis settings
for GlobalFiler™
Express data

AmpFLSTR_Bins_v3X stutter files
e GS600_LIZ_(60-460) size standard

GlobalFiler_Express_v1.1X panel, AmpFLSTR_Bins_v3X bin, and

IMPORTANT! Before using the Normalization option, perform appropriate internal

validation studies.

3500 and 3130

3730

Analysis Method Editor

-

r

Analysis Method Editor

e

General | Allele| Peak Detector | peak Quality | SQ & GQ Settings|

| General [ Allele| Peak Detector | peak Quality | 5Q & GQ Settings|

Peak Detection Algorithm: Advanced

Peak Detection Algorithm: Advanced

rSmoothing and Baselining

Smoothing () None
Light
_ Heavy

Baseline Windo... |33 pts

Ranges Peak Detection
Analysis ; .SiZi”Q - Peak Amplitude Thresholds:
\Full Range  w | |Partial Sizes = g: 175 R 175
Start PL:|0 Start Size: 60
G: 175 P: |175
Stop Pt:|10000 | Stop Size:|500
175 0: 175

Min. Peak Half Wid... |2 pts
Polynomial Degree: |3

Peak Window Size: |13 pts
Slope Threshold

~Size Calling Method
(7) 2nd Order Least Squa...
(@) 3rd Order Least Squa...
) Cubic Spline Interpola...
) Local Southern Met...
() Global Southern Me...

Peak Start: 0.0
Peak End: 0.0

MZation

["] use narmalization, if appl...

Factory Defaults

Ranges Peak Detection
Analysis | Sizing . Peak Amplitude Thresholds:
\Full Range  ~ | Partial Sizes | 8: [200 R 200
Start Pt:|0 Start Size: 60
i G: 200 P: 200
Stop Pt:|10000 | Stop Size:| 500
Y. 200 0. 200
~Smoothing and Baselining————
Min. Peak Half Wid... 2 pts

(@) 3rd Order Least Squa...
| Cubic Spline Interpola...
() Local Southern Met...
(! Global Southern Me...

( Normalization

Smoothing (@) None !
() Light Polynomial Degree: 3
() Heavy Peak Window Size: |9 pts
Baseline Windo... 33 | pts Slope Threshold
Peak Start: 0.0
rSize Calling Method Peak End: 0.0
(") 2nd Order Least Squa...

|| use Hormalization, if appl...

Factory Defaults

Save As H Save H Cancel H Help ]

I Save As H Save H Cancel H Help ]

IMPORTANT! Before analyzing 3730 data, see “3730 DNA Analyzer allelic ladder

failures” on page 57.
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Results

All metrics were met as described in Table 11. In all cases, the contents of the
genotypes table from v1.3 and v1.4 software match each other.

Table 11 Summary of data collection software verification testing results

Testing Categories

Subcategories

Expected Outcome

Result

3130/3730 Data
Collection software
A

3500 Data Collection
Software v2

3500 Data Collection
Software v1

Run setup,
instrument
control, and data
collection of 5-dye
and 6-dye
samples.

Genotyping

Proper operation and data collection of samples processed
with existing AmpF(STR® Kits and the GlobalFiler™ Express
Kit.

100% concordance between new and earlier versions of
Data Collection Software.

Pass. For
more
information,
see
“Capillaries
Viewer issue
in Data
Collection
Software v4”
on page 57.

Pass. For
more
information,
see “3730
DNA
Analyzer
allelic ladder
failures” on
page 57 and
“3730 DNA
Analyzer
sizing
failures” on
page 60.

100% concordance between 3130, 3730, and 3500
instruments.

Pass

Sizing precision

e Standard deviation of mean size within a run is <0.15 bp
for all alleles in the allelic ladder.

¢ Size range within a run is <0.5 bp for the largest allele in
the allelic ladder.

Pass

Sensitivity

Signal intensity of 6-dye samples meets specifications with
no allelic dropout at 125 pg total DNA input

Pass

54
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Table 12 Summary of GeneMapper® /D-X Software v1.4 testing GlobalFiler™ Express Kit verification testing

Testlng Subcategories Expected Outcome Result
Categories
GeneMapper® ID- | Allelic ladder ¢ 100% concordance for sizing, genotyping, and PQV scoring | Pass. For
X Software v1.4 genotyping between GeneMapper® ID-X Software v1.3 and v1.4 more
testing (without ACC). information,
GlobalFller * 100% accurate allele calling, PQV scoring, and PQV see 3730 DNA
Express Kit flagging for 20 allelic ladders from each instrument. Analyzer
allelic ladder
failures” on
page 57.
Sample ¢ 100% concordance of allele calls between single-source Pass. For
genotyping (population) and positive control sample and more
corresponding allele calls generated with Identifiler®, information,
NGM SElect™, and Yfiler® Kits. see “3730 DNA
* 100% concordance of sizing, genotyping, and PQV scoring | Analyzer
between GeneMapper® ID-X Software v1.3 and v1.4 al_Lellc l?dder
(without ACC]. failures™ on
. . page 57.
e 100% accurate allele calling, PQV scoring, and PQV
flagging for all sensitivity samples, 1 positive control, and
1 negative control from each instrument.
Mixture Analysis All mixture analysis calculations and flags are 100% accurate | Pass
when compared to visual inspections or results obtained with
third-party tools when using the same analysis methods and
thresholds.
Concordance Genotyping, peak ¢ 100% concordance of allele calls with Sample Spike Pass
testing with detection, PQVs Detection enabled.
GeneMapper® ID- » 100% concordance of peak height, area and data points
X Software v1.3 with and without normalization.
* 100% concordance of all PQV scores, including SQ, with
Sample Spike Detection enabled.
Mixture Analysis 100% concordance of mixture analysis results, calculations of | Pass
MIT pruning, sample segregation, pattern extraction, Ul flag,
Known matching, RMP, CPI, LR, and multi-kit merging.
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Testln_g Subcategories Expected Outcome Result
Categories

Verification of ACC and AN PQVs, ¢ 100% concordance of allele calls compared to results from Pass

newvl.4 software | Y Marker check Yfiler® kit data and visual inspections.

features and box in Panel  The ACC values and flags are 100% accurate.

updates Manager (new)
Spike Detection e SPK flag is N/A when spike detection is disabled with and Pass
disable/enable without the presence of a spike.
function for e SPKflagis Check /. when spikes are present in a marker
samples (new) and sample Spike Detection is enabled.
SPK PQV for e SPKflag is Check ;% for markers that contain a spike but Pass
markers that no alleles.
containaspike but | o SpK flag is N/A when spike detection is disabled with and
no alleles (update] without the presence of a spike.
Define New Supports .hid files. Pass
Sample Path
function
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Testing
observations

3130x Series Data Collection4

File View Help

% & [EEFRRR]

=/ b GA Instruments

* Capillaries Viewer issue in Data Collection Software v4

e 3730 DNA Analyzer allelic ladder failures
¢ 3730 DNA Analyzer sizing failures

Capillaries Viewer issue in Data Collection Software v4

The first time you add capillaries in the Capillaries Viewer (displayed by selecting
Capillaries Viewer in the left navigation pane), the software may incorrectly display
dye colors in some of the capillaries. This is a display issue only. The sample file (.fsa
file) is written correctly and the data will display correctly in GeneMapper® ID-X

Software. To correct the colors, refresh the display by clicking on another window,
then clicking on the Capillary Viewer again.

No User is ed i

- [ Results Group

- g=dDatabase Manager
=B |ga3130%

[ Plate Manager

- Hy Protocol Manager
~{JModule Manager
= HRun History

i -EHEPT Viewer

i EJeventLog
@y Instrument Protocol

Capillary Viewer|
BB Cap/array Viewer

L. PFReextraction
Outdated
[EZjinstrument Status

!lRun Scheduler

EHRun view

B Capilaries Viewer
BBl Cap/array Viewer
i | Spectral Viewer
+--&™Manual Control

i Eservice Log

Spatial Calibration Vief

[ spectral Calibration

B spatial Run Scheduley

4
M

GA Instruments > ga3130x| > Run History > Capillary Viewer

Select a run to view: Run_Outdated 2012-06-25_14-49 0.

Capillary 5

Capillary &

-

1 5 10 15
Selemcaplllanestod\splay" O A O A O 7 A

Capillary 7

aooo
4000
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1} 1000 QUDU 3000 4000 5000 Go00 roon 8000 9000 10000
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12000 peaks |nc_orrectly
- displayed in purple
4000 “ 2000
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Intensity vs Scan Number
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4000 H 4000
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-4000 -4000
1} 1000 QUDU 3000 4000 5000 [{a]uli) roon 8000 9000 10000
Intensity vs Scan Mumber
12000
aooo
4000 | H— II -
o 11‘ N 1T T
-4000

3730 DNA Analyzer allelic ladder failures

The GeneMapper® ID-X Software uses an Allelic Ladder Quality Assessment to help
ensure the allelic ladders used for sizing are of acceptable quality. One of the metrics

used is base-pair spacing: within each marker, the base pair spacing between any two
ladder alleles is within the expected range (specified in the panel used to analyze).
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Software verification testing

On the 3730 Genetic Analyzer with POP-7"" polymer, the D25441 and D151656
markers in some allelic ladder samples did not pass the base-pair spacing quality
assessment when using Light Smoothing:

e Figure 2 shows the spacing rule failure for the D25441 marker.

¢ Figure 3 shows the spacing rule failure for the D151656 marker, with an

additional peak height ratio quality assessment failure caused by incorrect allele
assignments.

Figure 2 Example of base pair spacing error in the D2S441 marker

& [B Plot Setting: | Data Interpretation

0|~ | M7 Es | &

File Edit View Plots Tools Alleles Help

2@ | e ]| @EOEEE W | EED | Ei

Sample File Sample Hame 505 (50 |SSPK |MIX  |OMR |cBG
BJ_Precision_3730_BJAL_028_E07_3 fsa BJAL ‘ ‘ |° ] Mark Sample For Deletion, |
[Findel ] [AMEL ] [DEsTITe
i 5 78 20 52 34 5 E %0 52 94 9 E 100 102 104 105 108 10 12 14 1 18 120 12z

BJ_Precision_3730_B.JAL

_028_E07_2fsa

IR NN

BJAL

16
’7’7@ [] Mark Sample for Deletion
i —

3 118 120 122

1000

4

4

g

B

1

o4
74 6 T a0 82 84 86 B8 90 92 a4 El ag 100 102 104 06 108 110 112 114 11
! ] i i it

[ b

Sample File Sample Mame Sample IO Run Mame Panel Marker Dve | Allele 1 A_ Quality Value Details
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Figure 3 Example of base pair spacing error and incorrect allele assignments in the D151656 marker

Eile Edit Miew Plots Tools Alleles Help
& [&  Flot Setting: |Data Interpretation <[ | panes:[2 - EEOEEE W | B | WE Al @
e LA
Sample File Sample Name S05 (5@ [SSPK [MIX  |[OMR [CG@
BJ_Precision_#730_BJAL_DZ7_FU7_Zisa BJAL | | ‘ ‘o ] Mark Sample For Deletion |~
| = 0125 391 ] B2
143 133 205 263
100
500
410
200
, e WA
Bk W Gl B bl b7 b Gol fesll b B B B B bd
BJ_Precision_3730_BJAL_028_E0T7_2fs= BJAL o ] Mark Sample for Deletion T
] WA [D165539 |
145 165 134 205 224 N
300
500
400
200
I O PR
B o [ [ 04 04 (4 0
< | n 3
Sample File Sample MName Sample [0 Fun Mame Panel Marker Dye | Allelz1 A_ Quallty Value Details
BJ_Pracision_373[BJaL 5487 d36548047} B _Pracision_37;|GlobalFier_Fxpre D21511 |G [24 2~ (lca=00
B_Precision_373 | BJAL 5497d36548h47} | BJ_Precision_375| GlobalFiler_Expre |D18551 (] 7 =l
BU_Precision_373BJAL 1543736548047} | BJ_Precision_37; | GlokalFier_Fxprg DVS381 (6 |7 [ [{Cne ormore allelic ladder requirements have not been met. Ses below:
ST Fresen 3 [BIAL AT TRt Bl Freseon i CabaF i e [DosaaT v e 3 - The peak height ratio of the first ko labeled peaks is below the systern defined threshold of 0.5
- ke 1B . —Fxarg - Peak height ratio of the lowest and highest called alleles ofthe marker is less than 0.15
BJ_Precision_373|BJAL 15407 d36548b47} | BJ_Precision_37;|GlobalFier_Exprg D195433 Y |6 7| =lll- Base pair spacing of all called alleles ofthe marker (excluding OL)
B_Precision_373|BJAL 15497 036545047} BJ_Precision_37; | GlokealFiler_Expre | THO1 v |a 5 is notwithin expected range
B_Pr 373[BJAL 5497036548047} | BJ_P 377 | GlobalFiler_E FGA RE 1
| Precision_373) }|B_Precision 37 GlobalFiler_Expre, Due to the abaove reason(s), this ladder has not been used to generate hin offsets.
BJ_Precision_373[BJaL 5497436548047} [B)_Precision_37F|GlohalFiler_Exprq DI251045 [R |2 E
Bid_Precision_373[BJaL 540736548047} B _Precision_37;|GlobalFier_Fxprg D351 [R |7 8 The following guality value thresholds have not been met. Note these
BJ_Precision_373[BJaL 5487036548047} ) _Precision_37;|GinbsalFier_Exprg 0135317 [k [5 5 [AERS (D NG CETITINGD [Bie ca\culat@.n aireretia it elliEls (s
BJ_Pracision_373[BJaL 5487 d36548k4 7B _Precision_37; | GlobalFier_Fxprq D7S820 R [B 7 EQY | sz ‘ Obiservedelug ‘ Threshokd, ‘ £50 lelofimg, |
LPH | 157.00 | 75.0 | «=150.0R... [MiA
B_Precision_373 | BJAL 5497d36548h47} | BJ_Precision_375| GlobalFiler_Expre | SE33 R 42 )
BJ_Prec\siun_371 BJaL fS497d3554Eb47L BJ_Precis\on_GF; G\obalFiIer_Exprg 01031245 |P 3 9|

GeneMapper® ID-X Software Version 1.4 User Bulletin

The instances of spacing failures were significantly reduced by using the None setting
instead of the Light setting for Smoothing in the Peak Detector tab of the analysis
method as shown in the following table.

Table 13 Number and type of failures by Smoothing method used (out of 192 total allelic
ladders)

Smoothing setting/number of

Failure and marker allelic ladder failures

None

5 1
9 1

Light

Spacing failure with D2S441
Missing allele/spacing failure with D151656

IMPORTANT! Using No Smoothing can increase baseline noise. Perform appropriate
validation studies before using this setting. For more information on smoothing, refer
to the GeneMapper® ID-X Software v1.0 Reference Guide (Pub. no. 4375671).
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Software verification testing

Considerations when using the None setting for Smoothing:

¢ Using a Global Cut-Off setting in the Analysis Method Allele tab (for example, a
setting of 20%) may mitigate the increased baseline noise caused by the use of the
None setting for Smoothing.

¢ If you use a Global Cut-Off setting that is lower than any marker-specific stutter
setting for any locus, you should still apply the Marker-Specific Stutter Ratios
(Analysis Method Allele tab). For example, if a stutter ratio is 12% but the Global
Cut-Off setting is 10%, you should still apply the Marker-Specific Stutter Ratio of
12% for the locus (to ensure stutter peaks between 10-12% are not labeled).

3730 DNA Analyzer sizing failures

Due to the small fragment sizes analyzed by the GlobalFiler® Express kit, we did
observe that the 60 base-pair peak in the GS600v2 size standard can migrate close to
the primer peak region (Figure 4). One sample out of 250 in our validation study failed
sizing with the default size-standard definition (60 to 460 bp) because the 60 bp
size-standard peak fell within the primer region and was not accurately identified as a
size standard peak.

This issue can be addressed by either of the following steps:
* Re-inject samples that fail to recognize the 60 base-pair peak.

* Use the 80 to 460 bp size-standard definition after performing appropriate
validation studies (as a general rule, the 60 base-pair peak is not required for
accurate fragment sizing using the 3rd Order Least Squares sizing method).

Figure 4 Raw data example illustrating the migration of the 60-base-pair size-standard peak into the primer-peak region.
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Conclusions e The GeneMapper® ID-X Software v1.4 can be used to process sample files
enerated on all HID CE instruments and with existing AmpF(STR® kits and the
g g P
GlobalFiler" Express Kit.

* The same results for sizing, genotyping, and mixture analysis were obtained
using GeneMapper® ID-X Software versions 1.4 and 1.3.

* All updates to GeneMapper® ID-X Software v1.4 were successfully and correctly
implemented without deleterious effects on other software functionality.

¢ The 3130 and 3730 Data Collection Software v4 and 3500 Data Collection v2 can
be used to collect and analyze data generated with existing AmpFISTR® kits and
the GlobalFiler™" Express Kit. All updates to data collection software were
successfully and correctly implemented without deleterious effects on other
software functionality.

Based on the nature of the modifications addressed in this update, and the testing that
we performed, it is recommended that users evaluate this software as it pertains to
their laboratory workflow to demonstrate concordance to previously validated
GeneMapper® ID-X Software versions. Laboratories should determine the appropriate
level of testing required based on their internal software validation guidelines and
those of the appropriate governing agencies.
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